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1 Product Overview 
Active@ Disk Image is a Windows-based solution that allows you to 
create an exact image of the data stored in selected partitions of a hard 
disk or an image of the entire hard disk. You can protect your valuable 
data by regularly making a disk image and keeping it in a safe place. If 
you have trouble with data corruption, or if you want to refer to an 
archived version of a file, you can easily restore the data. 

1.1 Overview  and List of Features 
Active@ Disk Image allows you to create an image of the data stored in 
selected partitions of a hard disk or an image of the entire hard disk. 
Active@ Disk Image is partition-oriented and not file-oriented. In a file-
oriented system, you must select all the files that you want to archive. In 
a partition-oriented system, all files on the selected disk partition are 
saved into the archive. 

A partition-oriented approach offers two major advantages: 

There is no risk that you will overlook important files when performing the 
backup. All files on the disk are saved into the image file.  
The folder structure and all hidden system files are saved, guaranteeing 
reliable partition restoring. If the original partition is completely corrupted 
and unrecoverable, it is still possible to restore system partitions, data and 
installed software. 

1.1.1 Main Features 
Create and restore a disk image without having to restart the computer 
(in most cases).  
Optionally select only those sectors that contain useful information. The 
resulting disk image is smaller and it takes less time to create.  
Store a disk image in a local file, on a network drive or burn directly on 
CD/DVD/Blu-ray Disc.  
Create an exact (sector-by-sector) image for data recovery scenarios or 
for backing up partitions with unknown file systems.  
Make a disk image from any Windows-based hard disk (SATA, SCSI, USB, 
NVMe, FireWire, PC Card), USB Flash Drive or Floppy diskette. 
Create an ISO image from CD/DVD/Blu-ray disc and burn them back.  
Backup data from basic disks or dynamic disks.  
Configure image compression to achieve a balance between archive size 
and recording speed.  
Create an image of several disk partitions at the same time and store 
them in one archive.  
Automate image creation by setting up several disk images at once. 
Restore selected disk, partition or individual files from the archive.  
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Run Active@ Disk Image from Active@ Boot Disk to perform all disk 
image operations no matter what installed operating system is present. 
Setup an unattended imaging of a computer using scheduling. 
Simple procedures using easy-to-follow wizards.  
Record operations logs. There are three log formats supported: XML logs 
(used internally by software), plain text log (placed along with an image) 
and Windows Event log. 
Split a disk image into several files to make file handling easier.  
Use password protection for security.  
Exclude page files and hibernate file to improve recording speed and 
reduce backup file size.  
Easily transfer system and program files to several workstations with disk 
or partition cloning. Unicode support (file names and descriptions in Asian 
languages are supported). 
Backup disks partitioned with MBR or GPT. 
Create incremental and differential backups to save storage space.   
Copy partitions or whole disks to other disks (partitions) without creating 
an intermediate image, and resizing support. 
Send e-mail notification after image is created. 

 

1.2 System Requirements 
Active@ Disk Image requires the following hardware: 

Pentium processor or compatible  
1GB RAM 
Mouse (recommended)  

1.2.1 Supported operating systems: 
Windows 7 
Windows 8 
Windows 8.1 
Windows 10 
Windows 11 
Windows 2003 Server 
Windows Server 2008 
Windows Server 2012 
Windows Server 2016 
Windows Server 2019 
Windows Server 2022 
 
 

Both 32-bit and 64-bit versions of operating systems are supported. 
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 NOTE  When you use Active@ Disk Image from a bootable CD, it doesn't 
matter what operating system is installed on the hard disk. The bootable 
CD has a self-contained Windows PE system and Active@ Disk Image 
executes in that environment. When you use a bootable CD, you can 
create and restore a disk image from disks or partitions that contain any 
operating system. 

 NOTE  Due to an error on Terminal Server it is not recommended to install the 
software remotely on a terminal server. 
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1.3 Supported File Systems 
Active@ Disk Image supports the following file systems: 

FAT12  
FAT16  
FAT32 
exFAT  
NTFS 
ReFS* 
CDFS 
UDF 

NOTE  Active@ Disk Image can create a RAW disk image, making an exact 
sector-by-sector copy of a disk. This allows you to backup and restore 
data on any file system. 

 

NOTE  Resilient File System (ReFS) is a new file system from Microsoft 
introduced with Server 2012. It is also supported by Windows 8.1, 
Windows 10, Server 2016 and Server 2019. While Active@ Disk Image 
creates images of ReFS partitions in the same way as of other systems, 
it cannot change partition size during restore – it must match the 
original size. 

 

 





2 Using Active@ Disk Image 
You can easily create a backup, restore a file or verify a disk image using 
Active@ Disk Image wizard screens. Select the procedure from the main 
program window and follow the instructions.  

To help introduce you to the Active@ Disk Image workspace, read the 
following topics: 

2.1 Main Program Window  
2.2 Types of Images  
2.3 Dynamic Disks 

2.1 Main Program Window 
To open the main program window, in the main Windows menu select 
Programs/Active@ Disk Image/ Active@ Disk Image. 

The main program window contains a command menu bar, a panel that 
displays operations and a status bar.  

The Tools menu contains a list of the Active@ Disk Image operations. 
When you hover the mouse pointer over a command, a description of the 
command appears in the status bar.   

In the display panel, when you click one of the operations to select it, a 
description of the selected operation appears in a description panel, to the 
left.  

Operations in the display panel use wizards to step you through the 
procedures. The five Backup Operations are functions that you may 
perform with disk images. The Disk-to-Disk Operation copies data from 
one disk or partition directly to another disk or partition without making a 
disk image archive. The Other Operations provide additional services such 
as viewing application log and automating the tasks. 

To open a wizard dialog, double-click an operation in the display panel or 
select an operation from the Tools menu.  
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Fig. 1 – Main Program Window 

 

 

2.1.1 List of menu commands 
File  

View Log - Opens the View Log dialog box. You may view descriptions of 
all activities, including warning and error messages.  
Schedule Task – Opens the Scheduling dialog box. You may automate 
creating disk images by making and scheduling a task. 
Generate Script – Opens the Script wizard. You may record parameters 
for delayed execution from the script. 
Settings - Opens the Program Settings dialog box. You may configure 
the settings for data compression, image splitting and what type of data is 
recorded in the log file.  
Save Hardware Info - Saves information about all hard drives and 
partitions installed in the computer into an XML file.  
Create Boot Disk - Creates a bootable USB flash or CD/DVD disk. 
Partition Manager – launches the Partition Manager utility. 
Exit - Closes the program.  
 

View 
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Status Bar - Toggles the status bar display on or off.  
Refresh Devices – Rescans all disks attached to the system. This 
command might be useful when disk configuration has changed since the 
application started.  
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Tools  

Disk to Image - Opens the Disk to Image Wizard. Helps you to create a 
regular type disk image archive of an entire disk(s) or of selected 
partitions in the system.  
Image to Disk - Opens the Image to Disk Wizard. Helps you to restore 
data from a disk image archive.  
Create Raw Image - Opens the Create Raw Image Wizard. Helps you 
create a raw type disk image of only one partition or the entire disk.  
Clone Disk - Opens the Clone Disk Wizard. Helps you to transfer a 
sector-by-sector copy from one disk (partition) to another.  
Copy Disk to Disk - Opens the Copy Disk Wizard. Helps you to copy a 
single partition or a whole disk to another disk or partition. In contrast to 
Clone Disk partition size can be increased or decreased, also only data 
sectors are copied resulting in faster operation. 
Explore Image - Opens Active@ Disk Image Explorer. Helps you to 
browse through folders and files in a disk image as though it was a hard 
drive. You may select folders or individual files and restore them.  
Verify Image - Opens the Verify Image Wizard. Helps you check the 
integrity of a disk image archive file.  
Mount Image – Opens Active@ Virtual Disk. Allows you to mount 
images as virtual drives and access them from Windows Explorer or any 
application as normal drive. 
 

Help  

Help Contents - Opens the user guide.  
Check for Updates – checks if any updates are available to download. 
Send Feedback via Web – opens a web form in a browser, allowing 
you to leave comments and suggestions regarding your experience with 
Disk Image. 
Send Feedback via E-mail – allows you to send your feedback as E-
mail by launching your default e-mail program. 
Register Product – allows you to register the program if it is not done 
yet. 
About Active@ Disk Image - Displays information about the program 
version, licensing and copyright statements.  
 

2.1.2 About the status bar 
The status bar is at the bottom of the main program window. Here you 
may view the current status of the application or information about 
operation commands. When Active@ Disk Image is idle and ready to 
perform an operation, the status displays "Ready". 

To toggle the status bar on and off, from the View menu, click Status Bar.  
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NOTE  When you run Active@ Disk Image, the application gathers information 
about disks and partitions available to the system. During this 
preliminary operation, the status bar displays "Initializing..." and 
prevents most other operations from starting. If you try to open a 
wizard before this initializing is finished, Active@ Disk Image shows a 
message box with the status bar message in it. After initializing is 
finished, this message box closes automatically and the selected 
operation is started. 

 

2.2 About Disk Image Types  
Active@ Disk Image supports regular type and raw type disk images. 
Regular disk image is the default type and should be used in most cases. 
When raw disk image type is not mentioned explicitly in this guide, we are 
referring to the regular disk image. Another file format supported is ISO 
image. ISO images are used to store a copy of CD/DVD/Blu-ray disc in a 
file and stand apart from actual disk images. 

 

2.2.1 Regular disk images 
A regular disk image contains only data found in used sectors of a hard 
drive. This is done in order to reduce the size of the disk image file and to 
reduce the time it takes to create the disk image. 

One regular disk image archive can hold data from several partitions from 
one or more disks. When you select a partition to be backed up, all 
current data will be saved into the disk image archive. Data that is 
recognized as deleted files and unused partition areas are not recorded 
into the image. Windows page files and hibernation file data are also 
excluded from a regular type of backup because they contain temporary 
information which is useless to keep and restore. 

Active@ Disk Image can make a backup of any file system. If a partition 
selected for backup is formatted with a file system which is not supported 
by Disk Image natively (i.e. FAT or NTFS), a sector-by-sector (raw) 
backup will be performed. Keep in mind that this mode is different from 
raw disk images described below. The image of a partition of an unknown 
file system will be placed into an .ADI file; the major difference from 
NTFS and FAT partitions is that it will contain all sectors of the partition - 
used and free. 
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2.2.2 Raw disk images 
A raw disk image contains an exact, sector-by-sector copy of a single 
partition or disk. A raw disk image of a disk or a partition is a larger file 
than a regular disk image of the same disk or partition and it takes a 
longer time to create. 

A raw disk image archive can hold data from only one disk; either a whole 
disk or one partition from a single disk. It cannot contain more than one 
selected partition. To make a raw disk image of several partitions on 
various disks, you may create a separate raw disk image for each 
partition.  

2.2.3 ISO images 
ISO image is a standard format which contains an exact, sector-by-sector 
copy of an optical media as CD/DVD/Blu-ray disc. It is used automatically 
when a CD/DVD/Blu-ray disc is selected for backup. ISO image can be 
burned back to the optical media. 

2.2.4 When to use raw images 
In normal conditions, you will likely use regular disk images. A regular 
disk image has the following advantages over a raw disk image: 

A regular image file is smaller than a raw image file (while containing all 
your valuable and usable data).  
It takes less time to create a regular image than it takes to create a raw 
image.  
The regular image process has advanced features like storing several 
partitions in one image, password protection and variable compression 
options.  
 

Raw disk images are more helpful in a data recovery scenario. Here are 
some reasons why a raw disk image is superior for data recovery: 

Data recovery technologies are based on searching the unused space on a 
partition for traces of deleted, lost or damaged files and folders. So-called 
"unused space" on a partition is not recognized by the file system and is 
not saved to a regular disk image. However, this space might contain 
valuable data information and it is saved to a raw disk image.  
The uncompressed raw disk image file contains a sequence of sectors that 
is unchanged from the original. There are no headers or other application-
specific identifiers added. As a result, the raw disk image can be viewed 
by any data rescue software as a mirror of your drive. If the integrity of 
the data on your live disk is questionable, you may want to experiment 
with the data on the partition image instead.  
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If file size is an issue, a compressed raw image may be used. Active@ 
Undelete is an example of data recovery software which can work with 
both compressed and uncompressed raw images.  
Raw images have no regard for the file system type. During the raw disk 
image recording process, all sectors are backed up. An image of any 
partition can be created and restored.  
If you want the data from a file to be restored from the disk image to the 
same exact location as they were before, then use a raw disk image. A 
regular image saves all current data but restores files to different sectors, 
allowing the partition to shrink or grow, depending on the size of the 
replaced file. In a regular situation, you should not be concerned about 
partition size. If the partition size is important, however, a raw image is 
the solution.  

2.2.5 About disk image file names 
Regular disk images  

Regular images have the file extension .ADI. 

All data is stored in one file or in a sequential series of numbered 
files. When the disk image is split into several files, additional file 
names are created by adding sequential numbers to the original 
name.  

Here is an example: If you save a regular disk image with the name 
MyImage, the application creates a file named MyImage.adi at the 
specified location for the first image file. If you have configured the 
operation to split the image after a fixed file size, or if the image is 
split automatically, the next file name is MyImage1.adi. The next file 
name after that is MyImage2.adi, and so on. 
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Raw images  
Raw images have the file extension .DIM. 

A raw disk image consists of two files: a configuration file and data 
file. The configuration file describes the disk or partition geometry 
and keeps the image description. This file has the .DIM extension. 
When verifying or exploring a raw image, select this file. 

The raw image data files have numerical extensions starting from 
.001 added to the whole image name. 

Here is an example: If you save a raw disk image with the name 
MyImage, the application creates a file named MyImage.dim. This is 
the configuration file. Data is stored in a file named 
MyImage.dim.001. If more than one file is created, the next file is 
named MyImage.dim.002, and so on. 

ISO images  
 
ISO images have the file extension .ISO. One .ISO file contains an image 
of one optical disc.  Thus for every optical drive selected the will be a 
separate .ISO file created.  
 
Backup folder 
When creating an image, all files belonging to it (.ADI or .DIM data files, 
.XML configuration file and optional text .LOG file) will be placed in one 
folder with the same name as the backup name. For example, if you 
choose a backup location such as C:\Backups and the backup name 
DiskImage, the main data file will have the name  
C:\Backups\DiskImage\DiskImage.adi 
 

 

2.3 Work ing w ith Basic or Dynamic Disks 
You may use Active@ Disk Image to backup and restore valuable data 
from both dynamic and basic disks.  

A basic disk uses partition tables supported by all versions of Windows, 
MS-DOS, and Windows NT. It can hold primary partitions, extended 
partitions, and logical drives.  

A dynamic disk has a different structure that is supported by Windows 
2000 and operating systems after Windows 2000. A dynamic disk can 
hold simple volumes, spanned volumes, mirrored volumes, striped 
volumes, and RAID-5 volumes. A single dynamic disk may consist of 
several physical disks.  
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In the Disk to Image Wizard, basic volumes are listed under each 
corresponding physical disk. Dynamic volumes are combined into a group 
named Dynamic volumes. To select all the physical dynamic disks in this 
group, select the group name.  When you select the whole group, all 
dynamic volumes are included in the backup. The contents of the dynamic 
volume is stored, however the structure data is not stored. What this 
means is that the information about dynamic disk (stripe, mirror etc.) is 
lost. 

If you try to create a raw disk image of one dynamic disk consisting of 
several physical disks you will not make a valid backup that allows you to 
restore the dynamic disk structure. However, you can create and restore a 
raw disk image of each physical dynamic disk.  

Active@ Disk Image does not allow you to restore the structure of 
dynamic disks. Nevertheless, you can restore the contents of dynamic 
disks to basic disks. 

2.4 Incremental and Differential Images 
Starting from version 4.0 there are 3 types of image which you can select 
when creating a new backup – full, incremental and differential. Full 
backup includes all data and is similar to previous images (but the image 
file format has been changed). Incremental and differential are based on 
the previous image and include only data changed since the last backup. 
The previous image is called a base image and can be a full backup or 
another incremental image. If, for a particular block, there’s no difference 
between current state and the base image, data is not written into the 
current image but a reference to a base image is placed instead. 
Differential image differs from an incremental image in the matter of 
allowing only a full backup to be a base image. 
 
The base image and all subsequent incremental images have the same 
partitions backed up. The create wizard dialog for incremental image 
shows the partitions selected for information purposes only; it does not 
allow to change the selection. If it appears that partition included into 
base image is no longer available or reformatted, the warning must be 
shown and the image creation seized.  
 
In an incremental image, if a password is used it cannot be changed.  It 
remains the same for the base and any subsequent incremental image. All 
other options like compression, file splitting, and description are individual 
for every image. 
 
Normally incremental images are named by the date/time of creation and 
located in the folder below the full backup, so the file structure will be as 
follows: 



2 Using Active@ Disk Image 

Active@ Disk Image User’s Guide  21 

 
  <Images location>\<Full backup> 
  <Images location>\<Full backup>\<Incremental 1> 
  <Images location>\<Full backup>\<Incremental 2> 
 
When you select any image as a base for incremental image, the 
application scans the parent folder and sibling folders (if it is not a full 
backup) or children folders (for full backup selected). All found images are 
enumerated and shown as a list from which user can select a required 
base image. If more than one image with the same sequence exists, it will 
be ignored. For example, the full backup has sequence #0, the first 
incremental image will have sequence #1. If another incremental image is 
created based on #0, it will become #1 again, so one of them will be 
ignored during the enumeration. 
 
When an incremental image is selected for restoring, all sequential images 
starting from the full backup and including the selected image must be 
presented in the folders as described above. 
 
Backward image compatibility is supported but forward is not. Images 
created with newer versions may have a different format. 
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3 Creating a Disk or Partition Image 
The Disk to Image Wizard steps you through the process of creating a 
disk image for a whole disk or a number of partitions.  

To open the Disk to Image Wizard, do one of the following: 

In the main program window, double-click Disk to Image.  
From the Tools menu, choose Disk to Image.  
Follow instructions on the wizard screens. In each case, click Next to 
move to the next screen. 

After the operation is complete, click Finish to close the dialog box. 

3.1 Selecting a Backup Type 
The first thing you need to do is select a backup type from Full, 
Incremental and Differential. The full backup is a normal backup 
containing all data for selected partitions. In most cases this is the type 
you will choose. Even if you consider making differential or incremental 
backups, the first backup you create (it is called a base backup) must be a 
full backup. 
 
Fig. 2 – Select Backup Type 

 
 
Incremental backup can be based on either full or another incremental 
backup. It contains only data that has been changed since the base 
backup was created, thus occupying less disk space and taking less time 
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to create. It is not self sufficient however and requires all previous backup 
images to get information from it (by restoring an image or exploring it in 
Disk Image Explorer). 
 
Differential backup is a backup type based on full backup. You cannot 
create a chain of differential backups - use incremental backup for this 
purpose. Technically a pair of full and first incremental backups is 
identical to a pair of full and differential backups. With differential backup 
you only need two images to restore data - a full backup and a differential 
made on top of it. 
  

3.2 Selecting Disks and Partit ions 
On this wizard page, select disks and partitions for back up. This list 
displays the disks installed in your system and the current partitions on 
them. If there any dynamic volumes in the system, they will be shown in 
one group named Dynamic Volumes. 

Fig. 3 – Select Disks and Partitions 

 
Information in this list is presented in five columns.  

Partition - The name of the hard disk or of the partition in the format 
<volume label>(<drive letter>:)   
Flags - The type of the partition. Options are:  

• Pri - Primary partition  
• Act - Active (bootable) partition  
• No flags indicate a logical drive  
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Capacity - The full partition size.  
Used space - The amount of space occupied by the current data stored 
in the partition. This shows the amount of data that will be backed up.  
Information - For a partition - the file system type is shown.  For a hard 
disk - the name assigned by the BIOS.  
Select a check box next to a disk or partition if you want to include that 
disk or partition in the disk image. The check box for a disk item has 
three-states:  

Clear - None of the partitions belonging to the disk is selected.  
Selected - All of the partitions belonging to the disk are selected.  
Undetermined - Some of the disk partitions are selected.  
At the bottom of the list a total size for the selected partitions is 
displayed. 

NOTE  You can select only partitions formatted with supported file systems. 
Partitions with other file systems, or unformatted partitions, cannot be 
selected and are shown without a check box.  Partitions without a drive 
letter will display a number with a colon instead of the drive letter. 

There are four types of devices supported, represented by different icons: 
hard drives, USB flash drives, floppy disks and CD/DVD drives. You may 
select partitions from all kinds of devices in one operation, however, only 
hard drives, USB flash and floppy partitions can be stored in one backup 
file. If you select a CD/DVD drive, an ISO image will be created for it and 
placed into separate subfolder. 

NOTE  If the image you are creating is an incremental or differential, you will 
see the list of selected partitions but won't be able to change the 
selection.  This is because you select a set of partitions to backup when 
you create a first, full backup.  For every subsequent backup you will 
only see the selection, but it is read-only.  You cannot change the set of 
partitions in incremental backup.  You also need to have all partitions 
selected during the full backup available on your machine while making 
an incremental or differential backup. 

 

3.2.1 BitLocker Volumes 
If a partition contains a volume, encrypted by Windows BitLocker, it’s 
marked so in the Information column. The encrypted partition must be in 
Unlocked state to be fully supported by Active@ Disk Image. If a partition 
is locked, all its data is in encrypted state and could not be parsed by 
Active@ Disk Image. It is still possible to backup and subsequently restore 
a partition in the locked state, but it implies several limitations: 
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• Since all data stored on the disk is in encrypted state, it cannot be 
interpreted and image is created in “raw” format, with all sectors 
included (with and without data) which results in a larger image 
size. 

• Image cannot be opened in Active@ Disk Image Explorer. 
• While the data partition can be successfully restored in encrypted 

state and subsequently unlocked using original key, the system 
Windows partition will be restored without the necessary 
modification which results in not bootable system 

To avoid the above-mentioned problems, unlock an encrypted partition 
before creating an image. In Windows 10 open Settings and search for a 
BitLocker: 

 
Open Manage BitLocker applet. You should see a window similar to this: 
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 Click on Unlock drive and provide a secret key. Now the drive should 
be in unlocked state and accessible by Active@ Disk Image. If you 
unlocked the drive while in Create Image wizard, click a Refresh button to 
update the state of the partitions in the list. 
 
You can also use a command line interface to manage BitLocker 
encrypted disks. Open a PowerShell app with Admin privileges and type 
manage-bde.  
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3.3 Choosing a Backup Location 
In this wizard screen, specify where to write the disk image archive.  

Fig. 4 – Indicate Backup Location 

 
When creating a regular backup, you have an option to select between 
writing an image into a local or network file, storing it in the cloud or 
burning it onto a CD/DVD. Raw images can be saved to file only. 

If you choose burning to CD/DVD, you need to select a burning device 
and enter a backup name. If you decide to store a disk image to a file, 
you need to provide a backup name and location. By default a folder 
named \Backups on a disk other than from which you are making backup 
which has the most of free space is suggested. 

When creating an image, all files belonging to it (.ADI or .DIM data files, 
.XML configuration file and optional text .LOG file) will be placed in one 
folder with the same name as the backup name. For example, if you 
choose a backup location such as C:\Backups and a backup name 
DiskImage, the main data file will have the name  
C:\Backups\DiskImage\DiskImage.adi. If you burn the disk image to 
CD/DVD, no extra folder is created and all files are placed in the root. 
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NOTE  Storing image on the cloud is available for Amazon AWS S3 service. You 
need to have an account properly configured and provide account 
credentials and selected bucket in Settings dialog. You can store full 
backup images (not incremental and not raw images) in the cloud. 

 

 If you choose to store image on the cloud, it will be stored in a folder 
named ActiveDiskImage and the name of the image should be 
unique. You can see the list of existing images by clicking on Browse 
button when Cloud storage option is selected. 

 

 

NOTE  When you choose to backup to a CD/DVD burner, you have to insert a 
blank disc and select a desired burn speed. You cannot move forward 
(the ‘Next’ button will be disabled) unless there’s a writable media in the 
target burner. You might also want to change default burner settings by 
clicking the Settings… button. 
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Fig. 5 – Burner settings 

 
First two options enable hardware burning optimization and buffer under 
run protection. It is highly recommended to leave them on. 

 

NOTE  You cannot burn an incremental or differential image to CD/DVD/Blu-ray 
disc. 

 

3.4 Setting Image Options 
Configure the compression settings, image splitting, and password 
protection and enter a description for the archive.   
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Fig. 6 – Image Options 

 
Compression  

The effectiveness of compression depends on the type of files in the data 
you are going to back up. Text documents can be reduced in size 
significantly. Trying to compress picture files or data that is already 
compressed, (for example, ZIP files) will yield a small file size difference. 

There are three compression settings indicated here by the affect each 
one has on the speed of the operation:  

None is in many cases the fastest option but will consume the most 
space. 
Fast (recommended) is a balance between compression speed and 
resulting image size  
Normal can give a better compression compared to Fast method but 
generally takes longer.  
High provides the smallest file size and takes the longest time to 
complete.  

NOTE  When you compare the size of an image created using Normal and an 
image created using High options the difference in file size is not 
significant. Because high compression takes significantly more time, use 
it only when you need to get the smallest possible image and when 
speed is not important.   

NOTE  When burning a backup directly to CD/DVD, image compression is not 
available and the only compression option enabled is None. 
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How to select compression method properly 

In most cases selecting a Fast compression method is a straightforward 
choice giving both speed and image size benefits, however here are some 
more detailed explanations behind the compression methods. There 4 
methods available: None, Fast, Normal and High. Each of them is 
progressively does a better compression but takes more time to do the 
job. The tests shown here are designed to illustrate the difference 
between the methods but their results highly depend on kind of data 
being compressed as well as hardware specifications. 
Text file 

               
Compression Speed Resulted size 
NONE (copy) 23100 MB/s 100% 
FAST 405 MB/s 62.5% 
NORMAL 225 MB/s 57.4% 
HIGH 68 MB/s 43.6% 

 
 EXE file 

               
Compression Speed Resulted size 
NONE (copy) 23300 MB/s 100% 
FAST 736 MB/s 46.4% 
NORMAL 286 MB/s 46.1% 
HIGH 80 MB/s 38.0% 

 

These tests were performed on i7-7700K desktop and show the pure 
performance of different compression methods which itself varies 
significantly on type of data used. Text files normally gives a good 
compression ratio (because compression engine has good chances to find 
repeated data and pack them) but takes longer due to necessity to find 
matches. Program files (executables) are similar to text in what they 
contain generally large amount of sparse data and can yield even bigger 
compression. JPEG and video files on the other hand are almost not 
compressible since they contain already compressed data. 

Those are artificial tests comparing compression itself, but in real life 
there are also different factors involved, like HDD speed for source and 
target disks, CPU speed and number of cores, kind of data being 
compressed. 
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i5-6500 @3.2 GHz, medium performance desktop, backup of system partition 
(21.3 GB) on HDD (7200 RPM) to another HDD (7200 RPM). 

 
 

 
i7-7700K @4.2 GHz, high performance desktop, backup of data partition, mostly 
project files (178 GB) from fast HDD (7200 RPM) to slower HDD (5400 RPM). 

 
Compression Time Image size, 

GB 
Speed Resulted size 

NONE 52:55 178 GB 57 MB/s 100% 
FAST 53:38 142 GB 57 MB/s 80% 
NORMAL 53:34 140 GB 57 MB/s 78% 
HIGH 52:33 131 GB 58 MB/s 73% 

 

It is obvious here that overall speed is mostly determined by hard disk 
speed and not by choice of compression method. In first test the target 
HDD is significantly faster than the one in the second test, resulting in 
much higher speed despite being run on less powerful machine. 
Generally, if machine is powerful enough, even high compression can be 
quite satisfactory in terms of the speed while giving the best compression. 
On the other hand, if CPU is struggling with compressing data, the speed 
impact could be drastic to extent prohibiting compression altogether (as 
an example if run on very slow Atom based PC, creating compressed 
image can take several times more time than not compressed image). 
Again, of both CPU and disk are fast (like in case with SSD), both CPU and 
disk speed might be equally important and Fast compression method 
could be more beneficial.  

Image splitting 

All image contents can be written into one file, depending on the size of 
the partition. When a disk image can be written into one file, the image 
file and the archive are the same thing. When Image splitting is set to 
Automatic (try single file), the resulting archive may be written into one 
file. 

Archive backups can be written to multiple files. Here are the situations 
when it is necessary to split the image:  

Compression Time Image size, GB Speed Resulted size 
NONE 4:05 22 GB 89 MB/s 100% 
FAST 3:47 14.7 GB 96 MB/s 69% 
NORMAL 4:15 15.1 GB 85 MB/s 70% 
HIGH 4:26 12.7 GB 82 MB/s 60% 
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Burning an image onto CD/DVDs. If you plan to create a disk image 
and then subsequently burn the created image onto CDs or DVDs, you 
must split the archive into files that can fit onto the media. Select the 
Fixed size (MB) check box and either type a file size in megabytes or 
make a choice from the drop-down list. Choices are:  

• 100 MB (ZIP)  
• 650 MB (CD)  
• 700 MB (CD) 
• 2GB (FAT)  
• 4GB (DVD)  

Saving image onto a FAT disk. You cannot create a file greater than 
4Gb on a FAT partition. In some situations, even 4Gb files cannot be 
handled properly. To provide the best data integrity on a FAT disk, select 
2GB (FAT) from the drop-down list or enter a smaller number manually.  
 

NOTE  If you select the Automatic (try single file) option, the archive will not 
necessarily be written into one file. If the system runs out of free disk 
space on the disk where you are saving the backup or if you are storing 
an image file on disk with a FAT file system, Active@ Disk Image 
automatically splits the archive into multiple files and prompts you for 
the path to write the next file.   

 

Password protection 

To protect sensitive data on a disk image, use password protection. 
Choose a password with a maximum of 16 characters. Type the password 
in the Password and Confirm password fields. Store your password in safe 
place. You will not be able to restore data from an image if you forget the 
password. 

 

Image encryption 

Professional version of Disk Image supports an image encryption in 
addition to password protection. If you select encryption option [None] 
but enter a password, an image will be protected from non-authorized 
access but its content will not be encrypted and although you cannot 
open the image without knowing a password using the Disk Image 
application, one can get raw data and try to descramble it and potentially 
extract sensitive information.  Encrypting the image protects it’s content 
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with widely accepted strong encryption methods making such access 
impossible. 

There are three options to encrypt an image: using AES-128, AES-192 
and AES-256 algorithms. They are considered modern and safe encryption 
methods. The difference between them is key length, the bigger the key 
length, the harder to decipher data using a brute force, though the 
encryption time will be longer. 

 

NOTE  Password for all incremental images in a series is shared and 
can be set only for full backup. If you are creating an incremental or 
differential image, the password field will be disabled. 

 

Image description 

You may give a short description of the contents of your image.  Enter 
descriptive text (maximum 1,024 characters) into the Image description 
text box. In this text box, you may use the Enter key to insert line breaks. 

NOTE  If the data that you are saving is confidential, be aware that the text 
that you enter into the Image description text box is stored as clear 
text. You are not required to use a password to view this description, so 
do not place confidential information here.  

Separating backups and naming images 

If you selected partitions belonging to different disks you have the option 
to split the data into separate image files, placing the data for each disk 
into a separate image. To do so, check “Create separate image for each 
disk” option. In this case the image name and location you specified 
before will become a root folder where two or more images for each disk 
will be placed. The names for these images are made based on disk’s 
numbers and names. You can change them by clicking on “edit names” 
link. 
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Fig. 7 – Edit image names 

 
You may rename the default names by selecting a name in the list and 
editing it in the text box above. 

Any CD/DVD images will be placed separately from the rest of the data 
automatically despite of “Create separate image for each disk” checkbox 
state, which controls all other data types. 

3.5 Creating Several Images at once 
The image splitting option described above is only a shortcut allowing you 
to separate data from different hard drives. You also can setup several 
backups at once while controlling every option. These images will be 
completely independent and created after each other. 



3 Creating a Disk or Partition Image 

36  Active@ Disk Image User’s Guide 

Fig. 8 – Create another image 

 
If you want only one image to be created, click Next button; otherwise 
select “Yes, configure another image” and click Next. You will be 
forwarded to the partitions selection page and will be able to set options 
for a second backup. 

3.6 Confirming the Disk Image Details 
Review the details of this page carefully. To change an item on this page, 
click Back and change an option, if needed, before proceeding. If 
everything is correct, click Next to start the process of image creation.   

The confirmation dialog contains three options to set: 

Verify image after creating – runs image verification immediately after 
the image is created. 
Shutdown computer when finished – turns off the computer when 
image creation is done. 
Minimize in tray – minimize application in system tray after starting the 
process. Active@ Disk Image icon will appear in the system tray showing 
the current progress when user hovers mouse over it. Double click on the 
tray icon restores application windows on the screen. If the application is 
minimized in tray, once the process finished, a system notification will be 
shown in the tray. 
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Fig. 9 – Confirming Operation Details 

 
 

The process of creating the image can take a long time. You can watch 
the progress bar on the Progress page.  

To stop the process of creating an image, click Cancel at any time. 

Fig. 10 – Progress Status 

 
Active@ Disk Image can be configured to send a notification e-mail after 
completing creating an image. See 10.4.5 Notifications Settings section 
for details. 



4 Creating a Raw Disk Image 
The Create Raw Image Wizard steps you through the process of creating 
a raw disk image.  

To open Create Raw Image Wizard, do one of the following: 

In the main program window, double-click Create Raw Image.  
From the Tools menu, choose Create Raw Image.  
Follow instructions on the wizard screens. In each case, click Next to 
move to the next screen. 

After the operation is complete, click Finish to close the dialog box. 

4.1 Selecting a Disk or a Partit ion 
Select a disk or a partition here to back up. This list displays the disks 
installed in your system and the current partitions on them.  

Because a raw image supports only one partition or disk per image, you 
may select only one partition or disk. If you select a disk, all its sectors 
(with all partitions) will be backed up. 

Fig. 11 – Select a Disk or Partition 

 

Information in this list is presented in five columns.  

Partition - The name of the hard disk or of the partition in the format 
<volume label>(<drive letter>:)   
Flags - The type of the partition. Options are:  
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• Pri - Primary partition  
• Act - Active (bootable) partition  
• No flags indicate a logical drive  

Capacity - The full partition size.  
Used space - The size taken by current data stored in the partition. 
Although all sectors will be written, this shows the amount of data the 
backup will contain.  
Information - For a partition - the file system type is shown.  For a hard 
disk - the name assigned by the BIOS. 

4.2 Choosing a Backup Location 
Specify where to write the raw disk image archive. 

Fig. 12 – Backup Location 

 
When creating an image, all files belonging to it (.DIM file, data files, 
.XML configuration file and optional text .LOG file) will be placed in one 
folder with the same name as the backup name. For example, if you 
choose a backup location such as C:\Backups and a backup name 
DiskImage, the main data file will have the name 
C:\Backups\DiskImage\DiskImage.dim. 

4.3 Setting Image Options for a Raw  Disk Image 
Configure the compression settings and image splitting and enter a 
description for the archive.   
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Fig. 13 – Image Options 

 
Compression  

The effectiveness of compression depends on the type of files in the data 
you are going to back up. Text documents can be reduced in size 
significantly. Trying to compress picture files or data that is already 
compressed, (for example, ZIP files) will yield a small file size difference. 

There are three compression settings indicated here by the affect each 
one has on the speed of the operation:  

None  is in many cases the fastest option but will consume the most 
space.  
Normal (standard compression) is a compromise between a smaller file 
size and a faster operation speed.  
High  provides the smallest file size and takes the longest time to 
complete.  
 

NOTE When you compare the size of an image created using Normal and an 
image created using High options the difference in file size is not 
significant. Because high compression takes significantly more time, use 
it only when you need to get the smallest possible image and when 
speed is not important.   

 

 

 

Image splitting 
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All image contents can be written into one file, depending on the size of 
the partition. When a disk image can be written into one file, the image 
file and the archive are the same thing. When Image splitting is set to 
Automatic (try single file), the resulting archive may be written into one 
file. 

Archive backups can be written to multiple files. Here are the situations 
when it is necessary to split the image:  

Burning an image onto CD/DVDs. If you plan to create a disk image 
and then subsequently burn the created image onto CDs or DVDs, you 
must split the archive into files that can fit onto the media. Select the 
Fixed size (MB) check box and either type a file size in megabytes or 
make a choice from the drop-down list. Choices are:  

• 100 MB (ZIP)  
• 650 MB (CD)  
• 700 MB (CD)  
• 2GB (FAT) 
• 4GB (DVD)  

Saving image onto a FAT disk. You cannot create a file greater than 
4Gb on a FAT partition. In some situations, even 4Gb files cannot be 
handled properly. To provide the best data integrity on a FAT disk, select 
2GB (FAT) from the drop-down list or enter a smaller number manually.  

NOTE  If you select the Automatic (try single file) option, the archive will not 
necessarily be written into one file. If the system runs out of free disk 
space on the disk where you are saving the backup or if you are storing 
an image file on disk with a FAT file system, Active@ Disk Image 
automatically splits the archive into multiple files and prompts you for 
the path to write the next file.   

 

Image description 

You may give a short description of the contents of your image.  Enter 
descriptive text (maximum 1,024 characters) into the Image description 
text box. In this text box, you may use the Enter key to insert line breaks. 

NOTE  If the data that you are saving is confidential, be aware that the text 
that you enter into the Image description text box is stored as clear 
text. You are not required to use a password to view this description, so 
do not place confidential information here.   
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4.4 Confirming the Raw  Disk Image Details 
Review the details of this page carefully. To change an item on this page, 
click Back and change an option, if needed, before proceeding. If 
everything is correct, click Next to start the process of image creation.   

The process of creating the image can take a long time. You can watch 
the progress bar on the Progress page.  

To stop the process of creating an image, click Cancel at any time. 



5 Verifying a Disk Image Archive 
After you have created a disk image, it is important for you to check that 
the data stored in the image archive is intact and can be read without 
errors. The Verify Image Wizard steps you through this process.  

 

To verify a disk image archive: 

1. To start the Verify Image Wizard, do one of the following:  
• Double-click the wizard icon on the main screen.  
• From the Tools menu, choose Verify Image.  

2. Follow instructions on the wizard screens. In each case, click Next to 
move to the next screen.  

NOTE  The process of verifying the image can take a long time.   

 

5.1 Selecting a Backup for Verification 
Specify the name of the archive that you want to verify.  

Fig.14 – Locate Source Image File 
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You may enter new image name into the File name field or use the 
Browse... button to select an image location in Open Backup File 
dialog box. If you use the Browse button, you may view details of the 
archive file like date, size and description without going further. 

Fig. 15 – Open Backup File 

 
The Open Backup File dialog box shows supported image files (having 
extensions .ADI and .DIM).  

When you select a disk image file, details of the selected file appear in the 
Backup Info area at the bottom of the dialog box. Details include image 
creation date and time, data size and the image description that you 
entered when you created the image. If the image is password protected, 
a small lock icon appears in the top-right corner of the Backup Info area. 

Click OK to return to the Backup Selection screen. The selected image 
name appears in the File name box.  

 

If you’d like to restore an image stores in the cloud, select Cloud 
storage option and click Browse to see a list of images available on the 
cloud. Once you have selected an image, its name will be placed into 
Backup name field. 
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NOTE  When a regular disk image is split into several files, the image 
description is placed into the last file of the archive.  If all files are 
located in the same folder, you can select any file in the image.  The 
application will automatically locate the last file of the archive and read 
the backup information.  If the last file cannot be found, the message in 
the Backup Info area indicates that The file is not the last file of 
multi-file archive.... Locate the last archive file and select it to open 
the image. 

 

You don't need to have all files in one place in order to start verifying the 
image. As each archive file location is required, the application requests a 
path to the file. 

5.2 Confirming the Verify Details 
View the file name and confirm that it is correct. To change the file name, 
click Back and choose a different image before proceeding. If the file 
name is correct, click Next to start the process of verifying the image.  

Fig. 16 – Confirm Operation Details 

 
The process of verifying the image can take a long time. You can watch 
the progress bar on the Progress page.  

To stop the process of creating an image, click Cancel at any time. 
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6 Restoring a Disk Image  
The Image to Disk Wizard steps you through the process of restoring a 
disk image archive of a whole disk or a disk partition.  

To open the Image to Disk Wizard, do one of the following: 

In the main program window, double-click Image to Disk.  
From the Tools menu, choose Image to Disk.  
Follow instructions on the wizard screens. In each case, click Next to 
move to the next screen. 

NOTE  You can restore more than one partition or disk at a time. If you restore 
a disk, all partitions belonging to the disk will be restored. If you want to 
restore more than one partition, you must choose “Yes, select 
another disk or partition” when prompted by Image to Disk Wizard.    

 

6.1 Selecting a Disk Image to Restore 
When you are restoring a disk image, you may restore an entire disk, or a 
partition. In either case, you must first select the disk archive. 

Fig. 17 – Locate Source Image File 
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To identify a disk image file, type the file name into the File name field.  

To open the Open File dialog box and view information about a number of 
archive files, click Browse... The Open File dialog box displays all 
supported image file types (with file extensions .ADI, .DIM and .ISO).  

Fig. 18 – Open Backup File 

 
Click a file in the list to select it. In the Backup Info area of the Open File 
dialog box, you can view the archive date, file size and description of the 
file. If the selected image is password protected, a small lock icon appears 
in the top-right corner of the Backup Info area. 

Click OK to return to the Backup Selection wizard screen. The selected 
image name appears in the File name field.  

Click Next to continue. 

If you’d like to restore an image stores in the cloud, select Cloud 
storage option and click Browse to see a list of images available on the 
cloud. Once you have selected an image, its name will be placed into 
Backup name field. 

NOTE When a disk image is split into several files, the image description is 
placed into the last file of archive. If all files are located in the same 
folder, you can select any file of the image. The application will 
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automatically locate the last file of archive and read backup information. 
If the last file cannot be found, the message in the Backup Info area 
indicates that “The file is not the last file of multi-file archive....”, 
locate the last archive file and select it to open the image. 

 

You don't need to have all files in one place in order to start restoring the 
image. As each archive file location is required, the application requests a 
path to the file. 

If the image you have opened is part of incremental backup, Active@ Disk 
Image looks for all incremental images in a series and shows them in the 
wizard. You have to select which incremental image (meaning which 
version of backup) to open. See section 2.4 for details on incremental 
images. 

Fig. 19 – Select Incremental Image 

 

6.2 Selecting a Whole Disk or a Partit ion 
After you have selected an archive, a list of partitions stored in that 
backup archive appears. Select the check box next to the disk or the 
partition that you want to restore. At the bottom of the list, a description 
of the selected image appears (if a description has been stored with the 
image).  
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Fig. 20 – Select Source Disk or Partition 

 
 

NOTE  You may select only one check box. If you select a disk, all partitions 
belonging to the disk will be selected. You can restore more than one 
disk (partition) in one operation. Once you have passed through all the 
wizard dialogs for the selected item, you will be prompted to add 
another disk (partition) to the restore operation. When you select 
another disk or partition to restore, the partition previously selected for 
restoring  will be represented by  icon. You may however select it 
again resulting in duplicating one partition in the backup into two on the 
target disk. 

The process for restoring a disk is different from the process for restoring 
a partition.  

When you restore a disk: 

All partitions that belong to the selected disk are restored.  
The operation is more automated and you have less control.  
You cannot specify the size and location of the partitions on the disk.  
You cannot assign a drive letter to a partition.  
All existing partitions and the data in them in the destination disk will be 
permanently removed to make space for the restored disk and its 
partitions.  
If the destination disk is a different size than the disk archive, all 
partitions in the disk image are restored to the destination disk using 
automatic resizing. The restored partitions will occupy all target disk 
space proportionally to their original size.  
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If the destination disk has the same disk geometry (sectors per track and 
tracks per cylinder) as the original one and it is of the same or larger size, 
you have an option to preserve the exact size and location of partitions on 
the disk being restored. 

NOTE   If you are restoring data from an image created on the same machine 
and it contains more than one disk, you may restore data in “Automated 
mode” by selecting two or more disks from the list. In this case you 
won’t be asked to select a destination disk but rather forwarded directly 
to the confirmation page. All the selected disks and the partitions they 
contain will be restored to their original location. 

When you restore a partition: 

You may choose the location of the partition.  
You may choose the size of the destination partition  
You may assign a drive letter to it.  
 

Restoring MBR and track 0 

When you create an image of a disk or a partition, the first track of each 
disk containing a MBR in sector 0 is stored in the backup. Normally track 0 
is filled with zeros, except the first sector, which contains the MBR 
(Master Boot Record) code and a partition table. The MBR code is 
necessary to boot a system from the disk and must be present on the disk 
containing an active partition. When a new disk is added to the system 
Windows must initialize it before use (you can do it in Disk Manager). 
During disk initialization a typical MBR is written to the first sector. 
Alternatively you may simply restore a partition to the new disk and 
Active@ Disk Image will also initialize it, so you should have no problems 
with booting from that disk.  

However, if you use a non-standard boot manager it might use a 
proprietary MBR code and extra code or data in sector 1 and below. If 
you make a backup of such a disk and later restore it as a whole disk, the 
whole first track (normally 63 sectors) will be restored automatically, so 
the alternative boot manager data will be restored. If you, however, 
decide to restore only a single partition to another (perhaps clean) disk, 
this proprietary MBR and data will be left behind. You have an option to 
restore the disk header (MBR and track 0) as a separate item when you 
are restoring that partition.  

When restoring a disk header (MBR and track 0), only sectors belonging 
to the first track are overwritten. The partition table on the target disk is 
also preserved, so it is safe to restore a disk header to the disk containing 
data and you can do it even after restoring a partition. 



6 Restoring a Disk Image 

52  Active@ Disk Image User’s Guide 

NOTE  If you are restoring a disk that has only one partition, keep in mind that 
the process of restoring a disk is different from the process of restoring 
a partition. If you select the partition in the image, you will proceed with 
partition recovery. If you select the disk, you will proceed with disk 
recovery.   

6.3 Restoring a Partit ion 
If you have chosen to restore a partition, you are said to be in "Partition 
Mode". You are going to restore a single partition that is stored in the disk 
image archive. You will have control over the parameters of the 
operation. You may restore to the existing partition (by overwriting it) or 
to unallocated space, provided that the target partition is large enough.  

Exclusive access to the target 

If the selected target is not an unallocated space, the restore operation 
must have exclusive access to the target partition while restoring the disk 
image. Before you confirm the details of the restoring operation, Active@ 
Disk Image attempts to lock the target partition for exclusive access. If 
another application or the operating system is using the target partition, 
you must close all applications or system processes that may be using the 
target partition.   

If you cannot lock the target partition after closing applications and 
system processes, there are other alternatives that you may try: 

Choose a different partition - Try to restore the disk image to a different 
partition.  
Restart the computer - Choosing this option will lead to rebooting your 
machine, so please close all applications first before selecting it. As an 
alternative you might restart your computer in a normal way (regular 
windows boot). After you restart, start Active @ Disk Image and repeat 
the attempt to restore the disk image.  
Force volume dismount - If you don't know what is preventing the 
partition from being locked, use force volume dismount. Keep in mind 
that all open file handles on the target partition will become invalid and 
the application that opened them might crash.  
 

NOTE  Although force volume dismount will work in most cases, it will not allow 
exclusive access when you are restoring a disk image to a system 
partition or to a partition that is involved with system memory 
pagefiling. If you are dealing with either of these two cases, you may 
run Active@ Disk Image from a bootable CD or start your computer in 
such a way that the target partition is not part of the operating system. 
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You can do this on a computer with multiple operating systems installed 
by booting into a different operating system.  Or, you can remove the 
target disk and install it into another computer where it will not be a 
system disk.   

 6.3.1 Selecting a Destination Partition 
After you have selected a partition image to restore, you must select a 
destination partition. 

Select a target partition to receive restored data from the disk image 
archive. The partition that you select must be big enough to hold all the 
data in the disk image. If you select a partition that is too small, the Next 
button is disabled. 

Fig. 21 – Select Destination Partition 

 
 

NOTE  Target partition size is not the only condition that must be met when you 
are restoring to a partition.  

Unallocated space located on the same level as primary partitions cannot 
serve as target for restoring if the following exist: 

Four primary partitions, or  
Three primary and one extended partition  
You cannot restore an extended partition onto itself. In the selecting 
partition page, an extended partition is represented by a green icon 
because it serves as a container for logical drives which can serve as a 
target.  
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If you restore more than one disk (partition) at a time, the partitions that 
are going to be created are marked with an icon . You cannot select 
this new partition as a target for another one. 

  

After you click Next, an attempt is made to lock the target partition for 
exclusive access. If the target partition is being used by another 
application or by the operating system, an error dialog box appears.  

Fig. 22 – Exclusive Access Required 

 
Select one of the solutions and click OK to continue. 

6.3.2 Choosing a Partition Type 
Choose how the restored partition will be used in the system. The 
restored partition may be Active, Primary or Logical.  
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Fig. 23 – Set Destination Partition Type 

 

 

Active - A hard disk can have only one active partition. As an Active 
partition, it is automatically set as Primary as well. If the selected disk 
image is a bootable partition, you must choose Active in order to allow 
the system to boot from it. If the target disk already has a system 
residing in an active partition, when you restore a disk image into a new 
active partition you will replace the existing active partition. All data on 
the formerly active partition will remain intact, but you will not be able to 
boot from it anymore.  

Primary - A hard disk can have up to four primary partitions. 

Logical - A hard disk can have an unlimited number of logical partitions. 
(The number of primary partitions is limited to three in this case.)  If the 
target disk does not have an extended partition, a new extended partition 
will be created and logical partitions will be placed in it. 

Single partition without MBR – This option is available for USB flash 
drives only.  Normally, USB flash disks do not have an MBR and their 
single partition is placed starting from sector 0. Nevertheless it is possible 
to create a flash drive with an MBR.  It might be the best option when the 
drive must be made bootable. 

 

If the image you are restoring contains only data, it does not matter what 
type of partition you choose.  
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NOTE  Only one partition on a disk can be set to active (the bootable partition).  
Choose Active type only when you are restoring a system partition and 
you want to boot from it. If you are restoring the image of a system 
partition only to retrieve the data from it, choose Primary or Logical.   

 

Your type choices on this page depend on what kind of partition you have 
chosen to restore: 

If you selected a primary partition or unallocated space at the primary 
level, you can restore image as primary, active or logical partition. If an 
extended (logical) partition already exists on the disk, your choice will be 
limited to primary and active partitions.  
If you selected a logical partition or unallocated space on an extended 
partition, you can make the new partition logical only. 
 
Active@ Disk Image supports restoring partitions to GPT disks. In 
Destination Partition Type you can now select not only partition type but 
also a partitioning scheme (partition style) which can be one of the 
following types: 

• MBR 

• GPT 

If you are restoring a partition to an already partitioned disk, the partition 
style is locked and the choice of partition type is limited to suitable values. 
If you, however, restore an image to a blank disk, you have a choice of 
partition style. 
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6.3.3 Specifying Partition Size 
Indicate the size of the restored partition. You may expand the partition in 
order to occupy more space than the original, or you may shrink the 
partition so that it uses less space on the restored partition.  

Fig. 24 – Specify Destination Partition Size 

 
The two calculated values on this page show the minimum and maximum 
size that the new partition may occupy. The maximum size corresponds to 
the size of the partition or unallocated space you have chosen as the 
target. The minimum size is determined by the amount of space used in 
the disk image of the source partition. 

You may change not only the size but also the position of the new 
partition by providing values for Free space before and Free space 
after. The sum of all three fields must be equal to the maximum size of 
the partition. When you change the value in one field, the wizard 
automatically recalculates the other values. If you enter an invalid value, 
all values are reset to the defaults. 

In a normal situation, you want the new partition to occupy the size of 
the target partition. If this is the case, do not change anything and click 
Next. If you want to make the new partition smaller than the existing 
target partition, change only the Partition size value. Free space is 
added after the partition. 

NOTE  You may enter only the approximate size of the new partition. The actual 
number may be slightly larger or smaller due to disk geometry 
alignments.   
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6.3.4 Assigning a Drive Letter 

NOTE  When running Active@ Disk Image from a Boot Disk (using Windows PE 
environment), it is not possible to assign a drive letter due to the 
temporary nature of Windows PE. This wizard page will not appear.   

 

To assign a new drive letter to the new partition, select a letter from the 
drop-down box. The list contains all drive letters that are unassigned. If 
the letter that you want to assign is already taken, it will not be in the list. 
To use a letter that is already assigned, you must close Active@ Disk 
Image and free that letter. After the letter is free, start Active@ Disk 
Image again and return to this page. 

Fig. 25 – Assign a Drive Letter 

 
To allow the operating system to assign the drive letter, click “No, don't 
assign drive letter”. In this case Windows will  assign a drive letter to 
the newly created partition by default, giving it the next free letter. 
However, if no letter is given to the partition you can use Disk Manager to 
assign a drive letter later.  

NOTE  The drive letter you choose might be very important if the restored 
partition contains installed programs. For example, if you created a disk 
image of programs on partition E:, you should restore the image back to 
a partition with the letter E:. Otherwise, all links stored in the registry 
that refer to those programs installed on E: will become invalid.   
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6.3.5 Restoring Multiple Partitions 
Once you are done with your selection, the wizard will prompt to restore 
another disk or partition. If you would like to, choose “Yes, select 
another disk or partition” and you will be forwarded to selecting 
another item.  

Fig. 26 – Restore Another  

 
 

If you need to restore only one disk or partition at a time, click Next to 
proceed to Confirmation dialog. 

 

6.3.6 Confirming Restore Details 
Review the details of this page carefully. To change an item on this page, 
click Back and change an option, if needed, before proceeding. If 
everything is correct, click Next to start. 
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Fig. 27 – Confirm Operation Details 

 
The process of restoring a partition or whole disk can take a long time. 
You can watch the progress bar on the Progress page. To stop the 
process at any time, click Cancel. 
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6.4 Restoring a Whole Disk 
If you have chosen to restore a whole disk, you are said to be in "Disk 
Mode". You are going to restore all the partitions that belong to the 
selected disk.  

You might consider Disk Mode as an automated mode. In Disk Mode, your 
only choice is the location of the target disk where the archive is to be 
written and then confirmation to proceed. 

Things that are automated are: 

The size and location of individual partitions  
The drive letter assignment  
 

If the target disk is larger than the saved image, the disk image is 
expanded so that the whole target disk is used.  All partitions on the disk 
image are resized automatically to take up the same proportional amount 
of space that they occupy on the disk image. 

For example, imagine an original hard disk with a capacity of 100 GB and 
two partitions: Partition A is 25 GB and Partition B is 75 GB. You create a 
backup disk image of this drive. The disk image file is 50 GB. When you 
restore the disk image, you choose to restore the whole disk. Here are 
three restore scenarios: 

If you restore the disk image to a 100 GB disk, then you will have two 
partitions: Partition A at 25 GB and Partition B at 75 GB.  
If you restore the disk image to a 200 GB disk, then you will have two 
partitions: Partition A at 50 GB and Partition B at 150 GB.  
If you restore the disk image to a 60 GB disk, then you will have two 
partitions: Partition A and Partition B may not be restored at the same 
proportional amount, depending on the amount of data that is stored on 
each partition. The goal is to restore all the data into two partitions.  
 
Exclusive access to the target 

If the selected target is not an unallocated space, the restore operation 
must have exclusive access to the target partition while restoring the disk 
image. Before you confirm the details of the restoring operation, Active@ 
Disk Image attempts to lock the target disk for exclusive access. If 
another application or the operating system is using the target disk, you 
must close all applications or system processes that may be using the 
target disk.   

If you cannot lock the target disk after closing applications and system 
processes, there are other alternatives that you may try: 
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Choose a different disk - Try to restore the disk image to a different 
hard disk.  
Restart the computer - Choosing this option will lead to rebooting your 
machine, so please close all applications first before selecting it. As an 
alternative you might restart your computer in normal way. After you 
restart, start Active@ Disk Image and repeat the attempt to restore the 
disk image.  
Force volume dismount - If you don't know what is preventing the 
partition from being locked, use force volume dismount. Keep in mind 
that all open file handles on the target disk will become invalid and the 
application that opened them might crash.  

NOTE  Although force volume dismount will work in most cases, it will not allow 
exclusive access when you are restoring a disk image to a system 
partition disk or to a partition that is involved with system memory 
pagefiling. If you are dealing with either of these two cases, you may 
run Active@ Disk Image from a bootable CD or start your computer in 
such a way that the target partition is not part of the operating system. 
You can do this on a computer with multiple operating systems installed 
by booting into a different operating system.  Or, you can remove the 
target disk and install it into another computer where it will not be a 
system disk.   

 

6.4.1 Selecting a Destination Disk 
After you have selected a whole disk image to restore, you must select a 
destination disk. 

Select a target disk to receive restored data from the disk image archive. 
The disk that you select must be big enough to hold all the data in the 
disk image. If you select a disk that is too small, the Next button is 
disabled.  
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Fig. 28 – Select Destination Disk 

 
 

If you restore more than one disk or partition, the target disk containing 
the new partition being created is marked with icon   here. It cannot be 
selected as a target disk here. 

 
If the destination disk has the same disk geometry (sectors per track and 
tracks per cylinder) as the original one and is the same or larger in size, 
you will see the option “Keep original size and location of 
partitions” enabled when you select that disk. If you leave this option 
checked, all partitions will be replaced to exactly the same place they 
were before and no partition resizing will take place. This might be 
especially useful when you are restoring a system partition and do not 
want the operating system to detect that it has been repositioned. 
 

After you click Next, an attempt is made to lock the target disk for 
exclusive access. If the target disk is being used by another application or 
by the operating system, an error dialog box appears. 
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Fig. 29 – Exclusive Access Required 

 
Select one of the solutions and click OK to continue. 

6.4.2 Confirming Partition Delete on Target Disk 
When you restore a disk image in Disk Mode, all partitions on the target 
disk - along with all data on them - must be deleted. This confirmation 
page is your final warning.   

Fig. 30 – Destination Disk Contains Partitions 

 
To proceed, select Yes, delete all partitions on the selected disk and click 
Next. 
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6.4.3 Restoring Multiple Partitions 
Once you are done with your selection, the wizard will prompt to restore 
another disk or partition. If you would like to, choose “Yes, select 
another disk or partition” and you will be forwarded to selecting 
another item.  

Fig. 31 – Restore Another 

 
 

If you need to restore only one disk or partition at a time, click Next to 
proceed to Confirmation dialog. 

6.4.4 Confirming Restore Details 
Review the details of this page carefully. To change an item on this page, 
click Back and change an option, if needed, before proceeding. If 
everything is correct, click Next to start.  



6 Restoring a Disk Image 

66  Active@ Disk Image User’s Guide 

Fig. 32 – Confirm Operation Details 

 
The process of restoring a whole disk can take a long time. You can 
watch the progress bar on the Progress page.  

To stop the process at any time, click Cancel. 

 

6.5 Restoring a Raw  Disk Image 
The Image to Disk Wizard steps you through the process of restoring a 
raw disk image archive of a whole disk or a disk partition.  

To open the Image to Disk Wizard, do one of the following: 

In the main program window, double-click Image to Disk.  
From the Tools menu, choose Image to Disk.  
Follow instructions on the wizard screens. In each case, click Next to 
move to the next screen. 

NOTE  If the raw backup contains an image of a whole disk, you will be 
prompted to select a disk as a destination. The steps to restore a raw 
whole disk are the same steps found in section 6.4 Restoring a Whole 
Disk, above. If the raw backup contains an image of a single partition 
you will be prompted to select a partition. The steps to restore a raw 
partition are the same steps found in section 6.3 Restoring a 
Partition, above, except that you cannot specify the partition size.    
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6.6 Burning an ISO Image 
ISO images are treated differently from regular ADI images. The term 
“restoring” applied to an ISO image means burning it back to a CD/DVD 
media. When a regular backup (.ADI file) or a raw image (.DIM file) is 
selected as a source, Image to Disk wizard will lead you to selecting a 
target disk or partition, selecting size, drive letter etc. However, when an 
ISO image (file with .ISO extension) is selected as a source image, the 
next wizard dialog will be Burn ISO Image, asking to select a burning 
device and set write speed.  

Fig. 33 – Burn ISO Image 

 
 

A blank writable media must be inserted and write speed selected in order 
to start burning. If no suitable media is detected in ‘selected device’, the 
Write Speed list box will be empty and button Next will be disabled. 

You may optionally change the burner settings by clicking the Settings… 
button. 
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Fig. 34 – Burn ISO Image 

 
 
 
The first two options enable hardware burning optimization and buffer 
under run protection. It is highly recommended to leave them on.  

After the Next button is clicked, the burn starts. The progress window 
reflects the status of the burning. 

Fig. 35 – Burn progress 
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6.7 Restoring a Floppy Image 
Floppy disk can be selected together with other partitions and placed 
inside the same ADI file as hard disk partitions. However, due to 
uniqueness of floppy partition, it can be restored only to a floppy disk. 

Again, since there is no MBR structure on a floppy disk and a single 
partition occupies the whole disk starting from sector 0, Floppy device 
cannot be selected. 

Fig. 36 – Selecting a destination for a floppy image 

 
As a result, when a floppy image selected in backup, only a floppy device 
can be a target. 

  

 

 



7 Viewing and Restoring Individual Files 
Active@ Disk Image Explorer is a utility that displays files and folders in 
disk image archives. You may browse through the file contents the same 
way that you would browse through the contents of a local disk using 
Windows Explorer. You may view the contents of the file and restore 
individual files from it.   

To open Active@ Disk Image Explorer, do one of the following: 

In the main program window, double-click Explore Image.  
From the Tools menu, choose Explore Image.  
After you launch Active@ Disk Image Explorer, you must open a disk 
image to browse through its contents.  

7.1 Opening an Image in Active@ Disk Image 
Explorer 
To open an image in Active@ Disk Image Explorer: 

3. To open the Open Disk Image dialog box, do one of the following:  
• In the toolbar, click Open Disk Image.  
• From the File menu, choose Open Image...  

4. In the Open Disk Image dialog box, browse to either a DIM file 
(raw disk image) or an ADI file (data backup). Select the file.  

5. Click Open.  

NOTE  If the disk image is password protected, the Type Password dialog box 
appears. Type your password in the Password field and click OK. 

If you have forgotten your password, an image that is password 
protected cannot be opened. This is a security feature.  

When you store a disk image with a password, please memorize it or 
write it down and keep it in a safe place. 

 

To close an image that you have opened in Active@ Disk Image Explorer: 

6. In the Opened Disk Images tree node, right-click a raw image or 
disk backup file.  

7. From the context menu, choose Close. 
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7.2 About the Active@ Disk Image Explorer Interface 
Active@ Disk Image Explorer is similar to the standard Windows-Explorer-
style interface with a tree view panel on the left side and a list view panel 
on the right. A log view appears in a panel at the bottom. Here you may 
view all events executed by the explorer. 

Fig. 37 – Active@ Disk Image Explorer 

 
In the tree view, you may open drives or partitions and select folders.  

View the contents of folders in the list view panel 

To view additional information about a selected item, click Info. 

7.3 Restoring Individual Files 
To restore a file or folder: 

8. In Active@ Disk Image Explorer, select a file or folder.   
9. To select multiple files or folders, do one of the following:  

• To select a consecutive list of items, click the first item and then 
press SHIFT and click the last item in the list.  
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• To select a non-consecutive list of items, press CTRL each time you 
click an item.  

10. To open the Restore Options dialog box, use one of the following 
methods:  
• On the toolbar, click Restore.  
• Right-click the file, and choose Restore... from the context menu. 

11. To give the file a name, you may use the file name that appears in 
the Name field or you may type a different name.  

12. To restore the file to a specific location, in the Restore To field, you 
may type a different path or click the ellipsis button (...) and browse 
to a restore folder location.  

13. Click Restore. 

8 Active@ Virtual Disk 
Active@ Virtual Disk allows to mount ADI or RAW image as a virtual disk 
drive and access its contents via Windows Explorer or any other file 
manager. 

8.1 Running Active@ Virtual Disk 
To Start Active@ Virtual Disk select Active@ Virtual Disk command in 
Active@ Disk Image folder in Start Menu. Active@ Virtual Disk will start 
and main window displaying open and mounted images will be shown. 
 
Alternatively you can launch Active@ Virtual Disk by clicking on Mount 
Image icon in the main screen of Active@ Disk Image or executing 
command Tools > Mount Image. 
 
A mounted image is available only as long as Active@ Virtual Disk is 
running, so you should not exit it if you want keep an image mounted. To 
stay active and at the same time to be not obtrusive, Active@ Virtual Disk 
normally runs in a System Tray. When you click a red close button in the 
right upper corner of main window, Active@ Virtual Disk does not stop but 
actually hides into system tray. To bring the main window back, find an 
icon of Active@ Virtual Disk in the system tray and double click on it. You 
can also right-click on the icon to show a context menu. 
 
To actually exit Active@ Virtual Disk, select Quit from context menu of 
Active@ Virtual Disk in the system tray. 
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Only one instance of Active@ Virtual Disk can be running at the same 
time, so if you accidently start the application again from the Start Menu, 
it will actually bring the running instance to the screen.  

8.2 User Interface 
Active@ Virtual Disk contains one window showing a list of open images, 
partitions inside them and mounting status 

 
 
At the top of the window there is a tool bar with buttons giving access to 
the main operations: 

• Add Image 
• Remove Image 
• Mount Partition 
• Unmount Partition 
• Settings 
• About 

 
Some of them might be disabled depending on the context. 

8.3 Opening and mounting disk images 
The procedure of mounting a disk image consists of two steps. 
1. Open an ADI or RAW image by clicking on Add Image button. 

The image will be open and added into the list. It will show the list of 
partitions it contains. (You can only open RAW image containing a 
single partition). 

2. Select a partition you’d like to mount and click the Mount Partition 
button. A drive letter selection dialog will be shown: 
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Select a drive letter and press OK. The image will be mounted and a new 
virtual drive will appear in Windows Explorer. You can work with it the 
same way as with a normal drive. A virtual drive is read-only and 
attempting to copy files to it or change data in it will fail. 
 
Active@ Virtual Disk must be running to ensure that virtual disk is 
working.  If you don’t want the main window to occupy screen space 
simply click on the Close button of the window - Active@ Virtual Disk will 
hide into the System Tray. Clicking on the tray icon will bring the window 
back. 

8.4 Un-mounting and closing images 
You should keep images open only as long as you use them. When you’re 
done with the image, it’s better to close the virtual disk drive.  
 
Select a mounted partition and click the Unmount Partition button in the 
toolbar. The partition will be unmounted and the virtual drive will 
disappear.  
 
Unmounting a partition does not close the image itself, so if you don’t 
need it, you can select an image and click the Remove Image button. 
 
If you simply remove an image without unmounting its partition first, all 
mounted drives will be unmounted automatically. The same is true when 
you exit the program – all mounted partitions will be unmounted and all 
open images closed.  
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You can also unmount all disks at once by selecting the Unmount All Disks 
command in the context menu in the program icon in the System Tray. 

8.5 Troubleshooting  
Active@ Virtual Disk keeps a log of operations like installing driver, 
opening and closing images, mounting and unmounting virtual drives. The 
log file is located in the installation folder (normally C:\Program 
Files\Active@ Disk Image) and is named virtdisk.log. It can show 
additional details about Active@ Virtual Disk operations. 
 
If you see any problem with installing a driver, mouting a partition or 
should the Active@ Virtual Disk crash, a stranded virtual drive, a machine 
reboot should be the best remedy. 

9 Clone Disk Wizard 
The Clone Disk Wizard steps you through the process of transferring data 
from one disk or partition to another by making an exact, sector-by-sector 
copy of the original. During the cloning process, a disk image file is not 
created. 

You may use the Clone Disk Wizard to make a copy of the same 
configuration from one hard drive onto a multiple other hard drives. For 
example, you may duplicate a hard drive configuration over several 
workstations on a network. If you are trying to recover data from a 
damaged hard drive or partition, you may clone the damaged partition to 
a number of other hard drives in order to experiment with different data 
recovery techniques on the copy rather than on the original. 

To open the Clone Disk Wizard, do one of the following: 

In the main program window, double-click Clone Disk.  
From the Tools menu, choose Clone Disk.  
Follow instructions on the wizard screens. In each case, click Next to 
move to the next screen. 

After the operation is complete, click Finish to close the dialog box. 

9.1 Selecting a Source Disk or Partit ion 
Select a disk or a partition that you want to clone.  

If you select a disk, all its sectors (with all partitions) will be selected. 
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Fig. 38 – Select Source Disk or Partition 

 
Information in this list is presented in five columns.  

 

Partition - The name of the hard disk or of the partition in the format 
<volume label>(<drive letter>:)   
Flags - The type of the partition. Options are:  

• Pri - Primary partition  
• Act - Active (bootable) partition  
• No flags indicate a logical drive  

Capacity - The full partition size.  
Used space - The size taken by current data stored in the partition. 
Although all sectors will be written, this shows the amount of data the 
backup will contain.  
Information - For a partition - the file system type is shown.  For a hard 
disk - the name assigned by the BIOS.  

NOTE Because you can clone only one partition or disk at a time, you may 
select only one item.    

 

9.2 Cloning a Partit ion 
If you have chosen to clone a partition, you are said to be in "Partition 
Mode". You are going to copy a single partition sector-by-sector from an 
existing hard drive. You will have control over some parameters of the 
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operation. You may write the clone data to an existing partition (by 
overwriting it) or to unallocated space, provided that the target is large 
enough.  

Exclusive access to the target 

If the selected target is not an unallocated space, Active@ Disk Image 
must have exclusive access to the target partition while writing the clone 
data. Before you confirm the details of the operation, Active@ Disk Image 
attempts to lock the target partition for exclusive access. If another 
application or the operating system is using the target partition, you must 
close all applications or system processes that may be using the target 
partition.   

If you cannot lock the target partition after closing applications and 
system processes, there are other alternatives that you may try: 

Choose a different partition - Try to restore the disk image to a 
different partition.  
Restart the computer - Choosing this option will lead to rebooting your 
machine, so please close all applications first before selecting it. As an 
alternative you might restart your computer in normal way. After you 
restart, start Active @ Disk Image and repeat the attempt to clone the 
partition.  
Force volume dismount - If you don't know what is preventing the 
partition from being locked, use force volume dismount. Keep in mind 
that all open file handles on the target partition will become invalid and 
the application that opened them might crash.  
 

NOTE  Although force volume dismount will work in most cases, it will not allow 
exclusive access when you are writing to a system partition or to a 
partition that contains a system memory page file. If you are dealing 
with either of these two cases, you may run Active@ Disk Image from a 
bootable CD or start your computer in such a way that the target 
partition is not part of the operating system. You can do this on a 
computer with multiple operating systems installed by booting into a 
different operating system.  Or, you can remove the target disk and 
install it into another computer where it will not be a system disk.   

 

9.2.1 Selecting a Destination Partition 
After you have selected a source partition to clone, you must select a 
destination partition. 

In the Selecting destination partition page, choose a target to write the 
cloned data from the source partition. You may clone the source partition 
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either to an existing partition - where all data will be overwritten - or to 
unallocated space.  

The target partition must have enough space to hold all the data from the 
source partition. 

Fig. 39 – Select Destination Partition 

 
The Next button will remain disabled until you select a partition that is 
large enough. 

 

NOTE  Because a clone is an exact copy of the source partition, you cannot 
change the size of the destination partition. If you choose a destination 
partition that is larger than the source, free (unallocated) space will 
appear after the cloned partition.   

 

NOTE  Target partition size is not the only condition that must be met when you 
are restoring to a partition.  

Unallocated space located on the same level as primary partitions 
cannot serve as target for restoring if the following exist: 

• Four primary partitions, or  
• Three primary and one extended partition  

You cannot restore an extended partition onto itself. In the selecting 
partition page, an extended partition is represented by a green icon 
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because it serves as a container for logical drives which can serve as a 
target.  

 

If the selected target is not an unallocated space, after you click Next, an 
attempt is made to lock the target partition for exclusive access. If the 
target partition is being used by another application or by the operating 
system, an error dialog box appears. 

Fig. 40 – Exclusive Access Required 

 
Select one of the solutions and click OK to continue. 

9.2.2 Choosing a Partition Type 
Choose how the cloned partition will be used in the system. The cloned 
partition may be Active, Primary or Logical.  
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Fig. 41 – Set Destination Partition Type 

 
Active - A hard disk can have only one active partition. As an Active 
partition, it is automatically set as Primary as well. If the selected partition 
is a bootable partition, you must choose Active in order to allow the 
system to boot from it. If the target disk already has a system residing in 
an active partition, when you clone a partition onto a new active partition 
you will replace the existing active partition. All data on the formerly 
active partition will remain intact, but you will not be able to boot from it 
anymore.  

Primary - A hard disk can have up to four primary partitions. 

Logical - A hard disk can have an unlimited number of logical partitions. 
(the number of primary partitions is limited to three in this case).  

Single partition without MBR – This option is available for USB flash 
drives only. Normally USB flash disks do not have MBR and their single 
partition is placed starting from sector 0. Nevertheless it is possible to 
create a flash drive with MBR. It might be the option when drive must be 
made bootable. 

If the image you're restoring contains only data, it does not matter what 
type of partition you choose.  

NOTE  Only one partition on a disk can be set to active (the bootable partition).  
Choose Active type only when you are cloning a system partition and 
you want to boot from it. If you are cloning a system partition only to 
retrieve the data from it, choose Primary or Logical.   
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Your type choices on this page depend on what kind of partition you have 
chosen to clone: 

If you selected a primary partition or unallocated space at the primary 
level, you can choose primary, active or logical partition. If an extended 
(logical) partition already exists on the disk, your choice will be limited to 
primary and active partitions.  
If you selected a logical partition or unallocated space on an extended 
partition, you can make the new partition logical only. 

9.2.3 Assigning a Drive Letter 

NOTE  When running Active@ Disk Image from a Boot Disk (using Windows PE 
environment), it is not possible to assign a drive letter due to the 
temporary nature of Windows PE. This wizard page will not appear.   

 

To assign a new drive letter to the new partition, select a letter from the 
drop-down box. The list contains all drive letters that are unassigned. If 
the letter that you want to assign is already taken, it will be not in the list. 
To use a letter that is already assigned, you must close Active@ Disk 
Image and free that letter. After the letter is free, start Active@ Disk 
Image again and return to this page. 

Fig. 42 – Assign a Drive Letter 

 
To allow the operating system to assign the drive letter, click No, don't 
assign drive letter. In this case Windows will assign a drive letter to the 
newly created partition by default, giving it the next free letter. However, 
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if no letter is given to partition you can use Disk Manager to assign a drive 
letter later.  

NOTE  The drive letter you choose might be very important if the cloned 
partition contains installed programs. For example, if your source 
partition is partition E:, you should write the clone to a partition with the 
letter E:. Otherwise, all links stored in the registry that refer to those 
programs installed on E: will become invalid.   

 

9.2.4 Confirming Clone Details 
Review the details of this page carefully. To change an item on this page, 
click Back and change an option, if needed, before proceeding. If 
everything is correct, click Next to start.  

Fig. 43 – Confirm Operation Details 

 
The process of cloning a whole disk can take a long time. You can watch 
the progress bar on the Progress page.  

To stop the process at any time, click Cancel. 

9.3 Cloning a Whole Disk 
If you have chosen to clone a whole disk, you are said to be in "Disk 
Mode". You are going to copy all the partitions, sector-by-sector from the 
selected source disk.  
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You might consider Disk Mode as an automated mode. In Disk Mode, your 
only choice is the location of the target disk where the archive is to be 
written and then confirmation to proceed. 

Things that are automated are: 

The size and location of individual partitions  
The drive letter assignment  
Exclusive access to the target 

The clone operation must have exclusive access to the target disk while 
writing to it. Before you confirm the details of the clone operation, 
Active@ Disk Image attempts to lock the target disk for exclusive access. 
If another application or the operating system is using the target disk, you 
must close all applications or system processes that may be using the 
target disk.   

If you cannot lock the target disk after closing applications and system 
processes, there are other alternatives that you may try: 

Choose a different disk - Try to copy the selected disk to a different hard 
disk.  
Restart the computer - Choosing this option will lead to rebooting your 
machine, so please close all applications first before selecting it. As an 
alternative you might restart your computer in normal way. After you 
restart, start Active @ Disk Image and repeat the attempt to clone the 
disk.  
Force volume dismount - If you don't know what is preventing the 
partition from being locked, use force volume dismount. Keep in mind 
that all open file handles on the target disk will become invalid and the 
application that opened them might crash.  

NOTE  Although force volume dismount will work in most cases, it will not allow 
exclusive access when you are writing data to a system partition disk or 
to a partition that is involved with system memory page filing. If you are 
dealing with either of these two cases, you may run Active@ Disk Image 
from a bootable CD or start your computer in such a way that the target 
partition is not part of the operating system. You can do this on a 
computer with multiple operating systems installed by booting into a 
different operating system.  Or, you can remove the target disk and 
install it into another computer where it will not be a system disk.   

 

9.3.1 Selecting a Destination Disk 
After you have selected a source disk to clone, you must select a 
destination disk. 
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In the Selecting destination disk page, select a target disk to receive 
cloned data from the selected disk. The disk that you select must be big 
enough to hold all the data in the source disk. If you select a disk that is 
too small, the Next button is disabled.   

Fig. 44 – Select Destination Disk 

 
After you click Next, an attempt is made to lock the target disk for 
exclusive access. If the target disk is being used by another application or 
by the operating system, an error dialog box appears.  

Fig. 45 – Exclusive Access Required 

 
Select one of the solutions and click OK to continue. 
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9.3.2 Confirming Partition Delete on Target Disk 
When you copy all partitions from a source disk in Disk Mode, all 
partitions on the target disk - along with all data on them - must be 
deleted. This confirmation page is your final warning.   

Fig. 46 – Destination Disk Contains Partitions 

 
To proceed, select Yes, delete all partitions on the selected disk and click 
Next. 
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9.3.3 Confirming Clone Details 
Review the details of this page carefully. To change an item on this page, 
click Back and change an option, if needed, before proceeding. If 
everything is correct, click Next to start cloning the disk. 

Fig. 47 – Confirm Operation Details 

 
The process of cloning a whole disk can take a long time. You can watch 
the progress bar on the Progress page.  

To stop the process at any time, click Cancel. 

 



10 Copy Disk to Disk Wizard 
The Copy Disk to Disk Wizard steps you through the process of 
transferring data from one disk or partition to another with an option to 
resize partition(s). Essentially it is like creating a disk image of one 
partition or a whole disk and subsequently restoring it to another disk or 
partition except there is no intermittent image created. 

 You may use the Copy Disk to Disk Wizard to make a copy of the same 
configuration from one hard drive onto a multiple other hard drives. For 
example, you may duplicate a hard drive configuration over several 
workstations. If you are trying to recover data from a damaged hard drive 
or partition, you may clone the damaged partition to a number of other 
hard drives in order to experiment with different data recovery techniques 
on the copy rather than on the original. 

 To open the Copy Disk to Disk Wizard, do one of the following: 

In the main program window, double-click Copy Disk to Disk.  
From the Tools menu, choose Copy Disk to Disk.  
 Follow instructions on the wizard screens. In each case, click Next to 
move to the next screen. 

After the operation is complete, click Finish to close the dialog box. 

10.1 Selecting a Source Disk or Partit ion 
Select a disk or a partition that you want to copy.  

If you select a disk, all its sectors (with all partitions) will be selected. 
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Fig. 48 – Select Source Disk or Partition 

 
Information in this list is presented in five columns.  

 

Partition - The name of the hard disk or of the partition in the format 
<volume label>(<drive letter>:)   
Flags - The type of the partition. Options are:  

• Pri - Primary partition  
• Act - Active (bootable) partition  
• No flags indicate a logical drive  

Capacity - The full partition size.  
Used space - The size taken by current data stored in the partition. 
Although all sectors will be written, this shows the amount of data the 
backup will contain.  
Information - For a partition - the file system type is shown.  For a hard 
disk - the name assigned by the BIOS.  

NOTE  Because you can copy only one partition or disk at a time, you may 
select only one item.    

 

10.2 Copying a Partit ion 
 If you have chosen to copy a partition, you are said to be in "Partition 
Mode". You are going to copy a single partition from an existing hard 
drive. You will have control over some parameters of the operation. You 
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may write the copy data to an existing partition (by overwriting it) or to 
unallocated space, provided that the target is large enough.  

Exclusive access to the target 

 If the selected target is not an unallocated space, Active@ Disk Image 
must have exclusive access to the target partition while writing the copy 
data. Before you confirm the details of the operation, Active@ Disk Image 
attempts to lock the target partition for exclusive access. If another 
application or the operating system is using the target partition, you must 
close all applications or system processes that may be using the target 
partition.   

If you cannot lock the target partition after closing applications and 
system processes, there are other alternatives that you may try: 

Choose a different partition - Try to restore the disk image to a 
different partition.  
Restart the computer - Choosing this option will lead to rebooting your 
machine, so please close all applications first before selecting it. As an 
alternative you might restart your computer in normal way. After you 
restart, start Active @ Disk Image and repeat the attempt to clone the 
partition.  
Force volume dismount - If you don't know what is preventing the 
partition from being locked, use force volume dismount. Keep in mind 
that all open file handles on the target partition will become invalid and 
the application that opened them might crash.  
 

NOTE   Although force volume dismount will work in most cases, it will not 
allow exclusive access when you are writing to a system partition or to a 
partition that contains a system memory page file. If you are dealing 
with either of these two cases, you may run Active@ Disk Image from a 
bootable CD or start your computer in such a way that the target 
partition is not part of the operating system. You can do this on a 
computer with multiple operating systems installed by booting into a 
different operating system.  Or, you can remove the target disk and 
install it into another computer where it will not be a system disk.   

 

10.2.1 Selecting a Destination Partition 
 After you have selected a source partition to copy, you must select a 
destination partition. 

 In the Selecting destination partition page, choose a target to write data 
from the source partition. You may copy the source partition either to an 
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existing partition - where all data will be overwritten - or to unallocated 
space.  

The target partition must have enough space to hold all the data from the 
source partition. 

Fig. 49 – Select Destination Partition 

 
The Next button will remain disabled until you select a partition that is 
large enough. 

NOTE  Target partition size is not the only condition that must be met when you 
are copying to a partition.  

Unallocated space located on the same level as primary partitions 
cannot serve as target for copying if the following exist: 

• Four primary partitions, or  
• Three primary and one extended partition  

 

If the selected target is not an unallocated space, after you click Next, an 
attempt is made to lock the target partition for exclusive access. If the 
target partition is being used by another application or by the operating 
system, an error dialog box appears. 
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Fig. 50 – Exclusive Access Required 

 
Select one of the solutions and click OK to continue. 

10.2.2 Choosing a Partition Type 
Choose how the copied partition will be used in the system. The copied 
partition may be Active, Primary or Logical on a disk with Master Boot 
Record (MBR) layout.  

Fig. 51 – Set Destination Partition Type 
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Active - A hard disk can have only one active partition. As an Active 
partition, it is automatically set as Primary as well. If the selected partition 
is a bootable partition, you must choose Active in order to allow the 
system to boot from it. If the target disk already has a system residing in 
an active partition, when you clone a partition onto a new active partition 
you will replace the existing active partition. All data on the formerly 
active partition will remain intact, but you will not be able to boot from it 
anymore.  

Primary - A hard disk can have up to four primary partitions. 

Logical - A hard disk can have an unlimited number of logical partitions. 
(The number of primary partitions is limited to three in this case.)  

Single partition without MBR – This option is available for USB flash 
drives only. Normally USB flash disks do not have MBR and their single 
partition is placed starting from sector 0. Nevertheless it is possible to 
create a flash drive with MBR. It might be the option when drive must be 
made bootable. 

If the image you're restoring contains only data, it does not matter what 
type of partition you choose.  

NOTE  Only one partition on a disk can be set to active (the bootable partition).  
Choose Active type only when you are cloning a system partition and 
you want to boot from it. If you are cloning a system partition only to 
retrieve the data from it, choose Primary or Logical.   

Your type choices on this page depend on what kind of partition you have 
chosen to clone: 

If you selected a primary partition or unallocated space at the primary 
level, you can choose primary, active or logical partition. If an extended 
(logical) partition already exists on the disk, your choice will be limited to 
primary and active partitions.  
 
If you selected a logical partition or unallocated space on an extended 
partition, you can make the new partition logical only. 
 

Active@ Disk Image supports copying partitions to GPT disks. In 
Destination Partition Type you can now select not only partition type but 
also a partitioning scheme (partition style) which can be one of the 
following types: 

• MBR 

• GPT 
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If you are copying a partition to an already partitioned disk, the partition 
style is locked and the choice of partition type is limited to suitable values. 
If you, however, restore image to a blank disk, you have a choice of 
partition style. 
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10.2.3 Specifying Partition Size 
Indicate the size of the destination partition. You may expand the 
partition in order to occupy more space than the original, or you may 
shrink the partition so that it uses less space than the original partition.  

Fig. 52 – Specify Destination Partition Size 

 
The two calculated values on this page show the minimum and maximum 
size that the new partition may occupy. The maximum size corresponds to 
the size of the partition or unallocated space you have chosen as the 
target. The minimum size is determined by the amount of space used in 
the disk image of the source partition. 

You may change not only the size but also the position of the new 
partition by providing values for Free space before and Free space 
after. The sum of all three fields must be equal to the maximum size of 
the partition. When you change the value in one field, the wizard 
automatically recalculates the other values. If you enter an invalid value, 
all values are reset to the defaults. 

In a normal situation, you want the new partition to occupy the size of 
the target partition. If this is the case, do not change anything and click 
Next. If you want to make the new partition smaller than the existing 
target partition, change only the Partition size value. Free space is 
added after the partition. 
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NOTE  You may enter only the approximate size of new partition. The actual 
number may be slightly larger or smaller due to disk geometry 
alignments.   

 

10.2.4 Assigning a Drive Letter 

NOTE  When running Active@ Disk Image from a Boot Disk (using Windows PE 
environment), it is not possible to assign a drive letter due to the 
temporary nature of Windows PE. This wizard page will not appear.   

 

To assign a new drive letter to the new partition, select a letter from the 
drop-down box. The list contains all drive letters that are unassigned. If 
the letter that you want to assign is already taken, it will be not in the list. 
To use a letter that is already assigned, you must close Active@ Disk 
Image and free that letter. After the letter is free, start Active@ Disk 
Image again and return to this page. 

Fig. 53 – Assign a Drive Letter 

 
To allow the operating system to assign the drive letter, click No, don't 
assign drive letter. In this case Windows will assign a drive letter to the 
newly created partition by default, giving it the next free letter. However, 
if no letter is given to the partition you can use Disk Manager to assign a 
drive letter later.  
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NOTE  The drive letter you choose might be very important if the copy partition 
contains installed programs. For example, if your source partition is 
partition E:, you should write the copy to a partition with the letter E:. 
Otherwise, all links stored in the registry that refer to those programs 
installed on E: will become invalid.   

 

10.2.5 Confirming Copy Details 
Review the details of this page carefully. To change an item on this page, 
click Back and change an option, if needed, before proceeding. If 
everything is correct, click Next to start cloning the partition.  

Fig. 54 – Confirm Operation Details 

 
The process of copying a whole disk can take a long time. You can watch 
the progress bar on the Progress page.  

To stop the process at any time, click Cancel. 

10.3 Copying a Whole Disk 
If you have chosen to copy a whole disk, you are said to be in "Disk 
Mode". You are going to copy all the partitions, one by one from the 
selected source disk.  

You might consider Disk Mode as an automated mode. In Disk Mode, your 
only choice is the location of the target disk where the archive is to be 
written and then confirmation to proceed. 
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Things that are automated are: 

The size and location of individual partitions  
The drive letter assignment  
Exclusive access to the target 

The copy operation must have exclusive access to the target disk while 
writing to it. Before you confirm the details of the copy operation, Active@ 
Disk Image attempts to lock the target disk for exclusive access. If 
another application or the operating system is using the target disk, you 
must close all applications or system processes that may be using the 
target disk.   

If you cannot lock the target disk after closing applications and system 
processes, there are other alternatives that you may try: 

Choose a different disk - Try to copy the selected disk to a different hard 
disk.  
Restart the computer - Choosing this option will lead to rebooting your 
machine, so please close all applications first before selecting it. As an 
alternative you might restart your computer in normal way. After you 
restart, start Active @ Disk Image and repeat the attempt to clone the 
disk.  
Force volume dismount - If you don't know what is preventing the 
partition from being locked, use force volume dismount. Keep in mind 
that all open file handles on the target disk will become invalid and the 
application that opened them might crash.  

NOTE  Although force volume dismount will work in most cases, it will not allow 
exclusive access when you are writing data to a system partition disk or 
to a partition that is involved with system memory page filing. If you are 
dealing with either of these two cases, you may run Active@ Disk Image 
from a bootable CD or start your computer in such a way that the target 
partition is not part of the operating system. You can do this on a 
computer with multiple systems installed, by booting a different system 
or you can remove the target disk and install it into another computer 
where it will not be a system disk.   

 

10.3.1 Selecting a Destination Disk 
 After you have selected a source disk to copy, you must select a 
destination disk. 

 In the Selecting destination disk page, select a target disk to receive 
copied data from the selected disk. The disk that you select must be big 
enough to hold all the data in the source disk. If you select a disk that is 
too small, the Next button is disabled.   
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Fig. 55 – Select Destination Disk 

 
 After you click Next, an attempt is made to lock the target disk for 
exclusive access. If the target disk is being used by another application or 
by the operating system, an error dialog box appears.  

Fig. 56 – Exclusive Access Required 

 
Select one of the solutions and click OK to continue. 
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10.3.2 Confirming Partition Delete on Target Disk 
 When you copy all partitions from a source disk in Disk Mode, all 
partitions on the target disk - along with all data on them - must be 
deleted. This confirmation page is your final warning.   

Fig. 57 – Destination Disk Contains Partitions 

 
 To proceed, select Yes, delete all partitions on the selected disk and click 
Next. 
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10.3.3 Confirming Copy Details 
Review the details of this page carefully. To change an item on this page, 
click Back and change an option, if needed before proceeding. If 
everything is correct, click Next to start copying the disk. 

Fig. 58 – Confirm Operation Details 

 
The process of copying a whole disk can take a long time. You can watch 
the progress bar on the Progress page.  

To stop the process at any time, click Cancel. 
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11 Other Operations 

11.1 View ing the Log File Details 
 

Active@ Disk Image keeps a record of every operation that it performs. 
You may view the details of this record to help overcome difficulties when 
saving or restoring a disk image.  

To open the View Log dialog box: 

14. From the File menu, choose View log... 

Fig. 59 – View Log 

 
The View Log window is divided into three panels. The left panel shows a 
list of all actions performed. Each item in the action list is a log. When you 
select a log in the action list, the top right panel displays information, 
warning and error messages that Active@ Disk Image created during the 
selected action or operation. When you select a message in the message 
list, details of the selected message are displayed in the bottom right 
panel. 

Each log in the action list has an icon that shows the resulting status of 
that action or operation: 
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   Action or operation finished successfully. 

   At least one warning message was created. The operation 
completed successfully in spite of the warning. 

   At least one error happened during the operation. The operation 
did not complete. 

   The operation is in progress. There are no errors or warnings at 
this point. 

 

To delete logs: 

15. Select a log in the action list.  
16. Click Delete.  
17. To delete all logs, click Delete All.  

NOTE  Besides regular logs you also have an option to create an additional text 
log. It contains the same information as a regular one. In order to 
create it, make sure that log check box is enabled at confirmation dialog 
of a wizard.  

 Besides XML log files in Logs folder accessible via GUI and text logs 
placed along with the image, Active@ Disk Image places logs into 
Windows Application log. These logs are created for administrator`s 
convenience and can be viewed by Event Viewer.  

  

11.2 Scheduling a Task 
 You can automate creating images by making a scheduled task.  This 

will run automatically at a time of your choice (unattended execution).  
When Active@ Disk Image is executing a scheduled task it runs without 
user interaction and does not have a GUI interface. If the execution 
started when a user was logged on, a console window will be shown 
displaying the progress of the operation executed. You do not need to 
be logged on in order to execute a scheduled task. If the execution has 
started when a user is not logged on the above mentioned console 
window will not appear – Disk Image will continue running until the task 
is finished. 

 Scheduled backups use a different schema of naming the images. Every 
image created automatically is placed in a folder named Backup-
<DATETIME> under the main backup folder. For example, if the backup 
location is C:\Backups and the backup name is DiskImage, the 
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scheduled backup files created on September 11, 2007 at 3:24pm will 
be placed in folder C:\Backups\DiskImage\Backup-2007-09-11-1524. 
Each scheduled backup may have several copies created at a different 
time as scheduled, each with its own timestamp. If two copies of a 
backup happen to have the same timestamp, the second copy will have 
“(1)” added to the backup name, i.e. C:\Backups\DiskImage\Backup-
2007-09-11-1524(1). 

 You may control how many previous copies of scheduled backups you 
want to keep. It is configurable in the Scheduling tab of the Settings 
dialog. Select 0 means that only the most recent copy will be kept. The 
previous copies of scheduled backups are erased only after the current 
backup is successfully created. 

NOTE  Task scheduling is not supported when Active@ Disk Image is running 
under Windows PE (from a Boot Disk).   

 

11.2.1 Tasks Dialog 
 You can get access to the configuration of tasks by double clicking the 

Schedule Task icon in the main window or by selecting menu 
command File / Schedule Task… 

  Fig. 60 – Scheduled Task dialog 

  
 The Scheduled Tasks dialog shows the list of created tasks with the 

following information: 
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 Name – the name you gave to the task. The icon preceding the name 
will indicate task status -  for an enabled task and  for a disabled 
one. 

 Status – either enabled or disabled. If you have a task and do not want 
it to be executed you might temporary disable it instead of deleting it. 

 Schedule – a short description of time (condition) to which the task is 
scheduled. 

 Next Run Time – time at which the task should run. 

 Last Run Time – the most recent time the task was executed. 

 

 To create a new task, click the Create button. You may create tasks for 
both regular and raw image backups. The second wizard dialog asks you 
to choose a backup type. The dialogs that follow are exactly the same 
as in Disk To Image and Create Raw Image wizards except you cannot 
schedule an image to be burnt onto CD/DVD. 

11.2.2 Scheduling a Task 
 After you are done selecting objects to backup, and specifying the 

settings options, you need to schedule the task in order to run it 
automatically. This dialog lets you select an appropriate launch 
condition.  

  Fig. 61 – Schedule Task 
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 Task description – give it a meaningful name in order to quickly find out 
what will be backed up. It is not the same as the image description 
which you entered in the Options dialog. 

 Enable task – if you don’t want the task to be executed yet leave the 
check box blank. The status of the task will be disabled. 

 Schedule task - the field that allows you to select a type of trigger upon 
which the task should be executed. You can choose between Daily, 
Weekly, Monthly, Once, At system startup, At user logon. Please note 
that the control set is changed as you select different trigger types. 

 Start time and date – the initial time when the trigger will execute. 

 End date – allows you to limit the period of the task execution 

 

11.2.3 Choosing Account Information  
 You need to provide a user name and a password of the account by 

which the task will be executed. Please be sure that the account you 
choose has administrative privileges. 

 

  Fig. 62 – Set Account Information 
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11.2.4 Pre- and post-execute commands 
You can specify which commands Active@ Disk Image should execute 
right before and after creating a scheduled image. This could be copying 
a disk image to central storage or doing cleanup as example. When 
creating a scheduled task simply specify required commands in the 
following dialog. Keep in mind that working directory is a folder where 
Active@ Disk Image installation is located, so plan shell commands 
accordingly. 
 

  Fig. 63 – Pre- and post-execution commands 

 

11.2.5 Confirming Task Details  
 Review the details of this page carefully. To change an item on this 

page, click Back and change an option, if needed before saving the 
task.  
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  Fig. 64 – Confirm Operation Details 

  
 A text log file will be created in the backup folder with the name of 

backup and .log extension. 

 

11.2.6 Viewing Task Details 
 After a task is created it appears in the tasks dialog list. To review the 

details of the task select the task and click the View button. 

Fig. 65 – View task details 
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11.2.7 Editing a Task 
 You can edit an existing task by selecting a task and clicking Edit 

button. The wizard will guide you through the same steps you followed 
when you created the task.  

11.2.8 Renaming a Task 
 You may want to rename an existing task if you find that its original 

name does not reflect the task’s purpose. To do that, click the Rename 
button in the Scheduled Tasks dialog after selecting the task you want 
to rename. 

11.2.9 Deleting a Task 
 When a task is no longer needed, you can delete it. Select a task you 

want to delete from the task list in Scheduled Tasks dialog and click the 
Delete button. 

11.2.10 Scheduling an incremental backup 
 Pro version of Active@ Disk Image supports creating an incremental 

backup as a scheduled task. When you create a new task the first 
wizard dialog you see is selecting a backup type. 

Fig. 66 – Choose a Backup Type 

  
 To create an incremental backup, select Incremental backup. The logic 

behind creating a scheduled incremental backup is slightly different from 
the one for manual backup. Here you won't be prompted for choosing a 
base image. The following schema is used in creating/naming 



11 Other Operations 

Active@ Disk Image User’s Guide  109 

incremental backups. The first created backup will be a full backup. 
Next, up to specified maximum incremental backups will be created. 
Then, again a full backup and a series of incremental backups will 
follow.  

 For example, if the backup location is C:\Backups and backup name is 
DiskImage and maximum of incremental backups is 3, the following 
backups will be created: 

 C:\Backups\DiskImage\Backup-2010-01-01 (full backup) 

 C:\Backups\DiskImage\Backup-2010-01-01\Incr-2010-01-02 (1st 
incremental backup) 

 C:\Backups\DiskImage\Backup-2010-01-01\Incr-2010-01-03 (2nd 
incremental backup) 

 C:\Backups\DiskImage\Backup-2010-01-01\Incr-2010-01-04 (3rd 
incremental backup) 

 C:\Backups\DiskImage\Backup-2010-01-05 (full backup) 

 C:\Backups\DiskImage\Backup-2010-01-05\Incr-2010-01-06 (1st 
incremental backup) 

 C:\Backups\DiskImage\Backup-2010-01-05\Incr-2010-01-07 (2nd 
incremental backup) 

 C:\Backups\DiskImage\Backup-2010-01-05\Incr-2010-01-08 (3rd 
incremental backup) 

 etc. 

 The limitation of number of incremental backups in a series is necessary 
to cap the dependency on previous backups, i.e. if the backup you need 
to restore is a 3rd incremental backup, you will need all three 
incremental backups and a full backup to get the data. The longer the 
chain of incremental backups, the higher number of files to worry about 
and potential risk of corruption, so it's best to keep it reasonably short, 
say under 10 backups. 
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Fig. 67 – Maximum incremental backups 

 

NOTE  Keep in mind, that "Number of previous backups to keep" counts only 
full backups, not incremental when deleting old backups. 

 Completed backups to keep is the total number of completed full 
backups to keep, including just created during the last task run. The 
parameter set to 1 means “delete all previous copies and leave only the 
most recent one which just has been created”. 

NOTE  When deleting old completed copies, Active@ Disk Image will also look 
for incomplete (read “corrupted” images) and will delete them all to 
reclaim the disk space. This clean up procedure will be performed only 
after current backup is successfully created, so there will be at least one 
good copy left. 

  

11.2.11 Viewing Running Task 
 When a task is executing by scheduler, it runs as a separate process 

without user interface. You can, however, see a task progress and stop 
the task if necessary, by launching Active@ Disk Image and executing a 
Running Task command from the main screen. 
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 If there’s no task running in background, a dialog message will say that, 
otherwise a dialog box similar to the progress dialog will show up. It will 
display the current status of the task being executed.  

You can stop the running task by clicking on “Abort” button. A signal will 
be sent to running process to terminate. Once it is finished, “Connection 
has been lost” message will be displayed.  

Fig. 68 – Running task dialog 

 

 If the running task is completed while Running Task dialog is open, a 
connection with it will be broken and a message “Connection has been 
lost. The task is, probably, completed.” will be shown. It is normal; 
simply close the Running Task dialog. 

11.3 Creating and Executing Scripts 
Besides scheduling backup tasks Active@ Disk Image (Pro version only) 
offers another way of executing tasks without interacting with the 
application and using GUI. It is called scripting. Using Generate Script 
wizard you create a script describing the action you would like to 
perform (creating or restoring image, copying or cloning a disk etc.). 
Then you run Active@ Disk Image with special parameters so instead of 
launching its GUI, it runs in console mode and executes a previously 
created script. 

When creating a script, you are not limited to creating a backup but 
rather can script any major task – create a backup, create a raw image, 
restore an image, copy or clone a disk or a partition. 
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The main benefit of using a script is unattended backup or restore from 
a batch file. If you have a sophisticated backup scheme based on batch 
file execution, you may incorporate Active@ Disk Image in it easily 
through using a script. When executing a script, Active@ Disk Image 
runs in console mode and provides output to the same console window 
it was launched from. When finished executing a script it returns an 
error code which can be analyzed further in a batch file to make 
decisions. User can also interrupt Active@ Disk Image script task by 
pressing CTRL-C while in console window. 

11.3.1 Creating a Script 
To create a script, launch a script wizard by double clicking Generate 
Script icon on the main window. The first wizard dialog offers you to 
choose which task you’d like to script.  
 

 Fig. 69 – Selecting a script task 

 
 
After choosing a task you are going to follow exactly the same wizard as 
you’d do when executing a task manually. For example, if you select 
Script Type as Disk to Image, you will be guided through the same 
dialogs as in Disk to Image wizard (selecting a backup type, disk and 
partitions to backup, backup location, options and confirmation). 
 
The main difference from regular task wizard is that instead of proceeding 
with execution of the task after a confirmation dialog you’ll be presented 
with another dialog named Save Script File. It shows a generated script 
text and allows saving the results either to a script file or to clipboard. 
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 Fig. 70 – Saving a script 

 
 
 

There are two ways to create and execute a script – as a script file or 
through command line parameters. A script file has an extension .DIS 
and follows a simple key=value structure. Using command line 
parameters allows you to avoid using a separate script file, and passes 
all script values to Active@ Disk Image as parameters. Keep in mind 
though that sticking with command line parameters may create a very 
long a cluttered command line. 

The task parameters the wizard describes are placed in [task] section in 
a script file. Normally there would be only one [task] section in the file 
but in some cases wizards may produce more than one task. For 
example, if you create an image of more than one hard disk and turn on 
the option “Create separate images for each disk”, script wizard will 
generate several tasks, one for each image to be created. Those tasks 
will be executed as independent entities one after another. Command 
line parameters allow describing only one task, so there will be more 
than one set of command line parameters generated each of them 
representing a separate call of Active@ Disk Image. 

11.3.2 Executing a Script 
To execute a script, run Active@ Disk Image with parameter /e following 
by a set of key/values pairs. The /e parameter must be the last in the set 
of command line parameters. 
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For example, to execute script file script.dis run the following: 
 
C:\>disk_image.exe /e f=script.dis 

 

If you want to use a set of command line parameters instead of .DIS 
file, you use the command line generated by a script wizard. It may look 
like this: 

C:\>disk_image.exe /e a=create 
bn="DiskImage5" bl="G:\DiskImage5\" c=1 fs=0 
s1=37eb37ea:63 s2=37eb37ea:311291505 
s3=37eb37ea:413689815 s4=37eb37ea:618486435 
s5=cc07cc07:63 s6=cc07cc07:204796620 
s7=cc07cc07:205198245 s8=cc07cc07:205602816 
l="G:\DiskImage5\DiskImage5.log" 
 
Keep in mind that in both cases you have to use a correct version of disk 
image executable: disk_image.exe for 32-bit environment or 
disk_image_x64.exe for 64-bit. You should run Active@ Disk Image from 
the path where it is installed. 
 
When executing a script Active@ Disk Image creates a console window 
which is used for program output. If you are running Active@ Disk Image 
from your batch file, this can be inconvenient as it will launch a separate 
console window. To change this behavior and use the existing console 
window of cmd.exe run Active@ Disk Image with parameter /c: 
 
C:\>disk_image.exe /c /e f=script.dis 
 
When launched in script mode Active@ Disk Image first parses provided 
parameters, then executes a task and reports the result. During the 
execution phase you may interrupt the process by pressing CTRL-C when 
the console window is in focus. It has the same effect as clicking the 
Cancel button when running the application in GUI mode. 
 
Upon finishing the execution Active@ Disk Image outputs the result into 
the console and exits with a return code. You may analyze the return 
code in your batch file to detect successful or failed execution. Active@ 
Disk Image may return the following values: 
 
0 – Success 
1 – Completed with warnings 
2 – Completed with errors 
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100 – Failed 
101 – Canceled 
102 – Feature not supported 
103 – Bad parameters 
104 – Cannot create folder 
105 – Cannot start thread 
106 – Cannot lock volume 
107 – Target folder not empty 
108 – Failed open image 
 
Return codes below 100 are generally considered successful. 
 

 

 

11.4 Changing Program Settings 
You can change the program settings in the Program Settings dialog.  

To open the Program Settings dialog box: 

18. 1. From the File menu, choose Settings... 

 Fig. 71 – Program Settings - General 

  
 To preserve the changes you made, click OK or the Apply button of the 

dialog. 

NOTE  When Active@ Disk Image is running under Windows PE (from a Boot 
Disk), setting changes are not retained as they are stored in the System 
Registry which is discarded after reboot. 



11 Other Operations 

116  Active@ Disk Image User’s Guide 

11.4.1 General Settings 
 In the General tab you can choose a user interface language by 

selecting one from drop-down list. 

 Show welcome screen in wizards. Normally wizards have an 
introductory welcome page describing the purpose of the wizard. You 
can choose not to show it by unchecking this option. 

 Check for updates when program starts. If this option is chosen, 
Active@ Disk Image will check for a newer version of the program when 
it starts. A working internet connection is required for this feature to 
work. 

11.4.2 Image Options Settings 
 This tab allows you to change default image options. 

Fig. 72 – Program Settings – Options 

   
 They include compression settings and image splitting. Every time you 

create a new image the wizard uses these settings as default. 

11.4.3 Logs Settings 
  

Fig. 73 – Program Settings - Logs 
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 Verbose logging is useful as a troubleshooting measure to locate the 

source of an error. 

11.4.4 Scheduling Settings 
 You may control how many previous copies of scheduled backups you 

want to keep.  

Fig. 74 – Program Settings - Scheduling 

   
  

 Selecting 1 means that only the most recent copy will be kept. The 
previous copies of a scheduled backup are erased only after the current 
backup is successfully created. 

 Maximum incremental backups parameter sets the default value for the 
number of incremental backups in sequence after a full backup. A value 
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of 5 means that a full backup will be created and 5 incremental backups 
after it, then the sequence repeats again - 1 full and 5 incremental. 

NOTE  This is default setting only. When you create a task, an Options page will 
contain Number of previous backups to keep parameter with the 
value taken from this setting. You may overwrite it, giving individual 
values for each backup. The same is true for Maximum incremental 
backups. 

 

11.4.5 Notifications Settings 
 Active@ Disk Image can send an e-mail notification on completion of 

image creation. All parameters concerning when and where to send 
notification is described in Notification settings tab.  

 Send e-mail notification for. This group of checkboxes sets  when to 
send notifications. Normally you want to get e-mail notification when 
image is creating automatically by scheduled backup or as part of a 
script. 

Fig. 75 – Program Settings - Notifications 

  
 Notify when result is. These options specify when to send 

notifications and correspond to the following result codes from creating 
image: 

1. Success – successfully created 

2. Failed – failed or cancelled by user 

3. Warning – completed with errors or completed with warnings 
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Subject – is a template used to make a message subject. It can contain 
two placeholders which are substituted with actual values: 

• {status} – string value of status (can be “Success”, “Warnings” 
or “Failed” 

• {code} – numerical value of status (0 – success, 1 – warnings, 
2 – failed) 

You are free to change subject template according to your needs. 
Including status string or numerical value could be useful when setting 
up a message filter. 

To: - enter a list of e-mail recipients separated by a semicolon. At least 
one e-mail address must be entered here. 

Account settings opens a dialog with SMTP account settings. 

Fig. 76 – SMTP settings 

 
Server Settings contains server name, port number, and security type. 
Normally, for non-secure connections, port 25 is used, and for SSL and 
TLS – ports 465 and 587 respectively.  However, your ISP provider may 
use different values.  

User Account enumerates user identity. If your SMTP server does not 
require authentication leave Login and Password empty.  

Sender is the name which will appear in From field in notification e-
mail. 

Test button allows to verify account settings. A test e-mail will be sent. 

 

11.4.6 Cloud Settings 
 Active@ Disk Image can use cloud storage services to store backups. 

Before you use them you need to configure access to cloud storage 
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through Cloud tab in Settings dialog. For using Amazon AWS S3 
service you need to setup it first and obtain a pair of access keys called 
Access key ID and Secret access key. Please refer to AWS 
documentation how to setup account, create an IAM user and use S3 
service. 

 

 Region. Select a region where to store images. Normally you would 
choose a data center closest to your location. For Eastern USA you 
might choose us-east-1. For full list of available regions and their codes 
see AWS doc: 
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/using-regions-
availability-zones.html 

 Bucket. Before using cloud storage, you need to create or select a 
bucket. Active@ Disk Image can share the bucket with other data; it will 
create a subfolder called ActiveDiskImage and store all backups 
inside that subfolder. 

 Split size. When images are stored in the cloud, they are automatically 
split into chunks of predefined size. In the cloud an image will look like a 
set of smaller files inside one folder. The most optimal size is 100 MB, 
but in some cases if connection is not stable on particular machine, you 
may want to reduce the split size to 50 MB, 20 MB or less. Don’t change 
this value unless you have a reason to do so. 

 Access ID. Provide an Access key ID for IAM user under which Active@ 
Disk Image will access the storage. 

 Access key. Enter a Secret access key for the mentioned Access ID. 

 

https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/using-regions-availability-zones.html
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/using-regions-availability-zones.html
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 Cloud settings are stored in Windows Registry. 

 When creating a Boot Disk using a Boot Disk Creator there is an option 
to provide cloud settings which will be available in Boot Disk 
environment once you booted from it. If you configured Cloud settings 
before creating a Boot Disk, Boot Disk Creator will pick them up and you 
will see them in the Cloud tab in configuration wizard. By providing the 
settings in Boot Disk Creator you will eliminate the need to configure 
Active@ Disk Image manually every time you boot from Boot Disk. 

 

11.4.7 Advanced Settings 
 Active@ Disk Image can use multiple threads for compression and 

encryption. This can significantly improve performance on multi-core 
machines. By default, Active@ Disk Image uses as many compression 
threads as the number of CPUs/cores detected on a machine.  However, 
there is an option to manually specify this number. Use it with care and 
do not specify a value larger than the number of CPUs/cores on your 
machine, as it might lead to performance degradation. 
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 Fig. 77 – Advanced settings 

  
 

10.5 Saving Hardware Information 
When you are performing maintenance on a hard disk, or if you are 
repairing or recovering lost or damaged data on a disk, you might want to 
record technical information about the disk before making changes. This 
information may be helpful if you need to remember the original 
configuration when restoring data after a system crash or when 
contacting technical support.  

This configuration information includes a list of all hard disks installed on 
your machine with details about all partitions and volumes. It will be 
saved as a XML file which most browsers will render in an easy-to-read 
format. 

To save hardware information: 

19. From the File menu, click Save Hardware Info... The Save As 
dialog box appears.  

20. Navigate to a folder location and type a name in the File name field.  
21. Click Save.  

NOTE  When you create a disk image, a Hardware Info file is created 
automatically. It is written into the same location as your disk image and 
has the same file name but with a .XML extension. You do not need this 
file to restore data from the disk image. The information in this file 
reflects the configuration at the moment of creating the image and it 
may be helpful in the event that you have any difficulty restoring the 
data.   



12 Troubleshooting 

12.1 FAQ (Frequently Asked Questions)  
Q. Does Active@ Disk Image work under Windows 98 or Windows 2000? 

A. No.  Active@ Disk Image requires Windows 7 or newer OS to run 
from a regular windows boot. However, if you use Active@ Disk 
Image from a Boot Disk, you may have any operating system - or no 
operating system at all - on your data disk. The purchased version of 
the software comes with a utility to create a boot CD /USB (which 
contains a Windows PE operating system). 

 

Q. Why do I get the error message "The file is not the last file of multi-file 
archive..." when I try to open an image file? 

A. When a regular disk image is split into several files, the image 
description is placed into the last file of the archive.  If all files are 
located in the same folder, you may select any file of the image.  The 
application will automatically locate the last file of the archive and 
read the backup information. If the last file cannot be found, you 
must locate the last archive file and select it to open the image.  

 

Q. What does it mean when I get the error message: "... call has failed. 
HRESULT = ..." ? 

A. When creating an image the program usually uses volume shadow 
copy service (VSS) to get a consistent image of a partition on the fly. 
This error means that either VSS or COM+ has failed. Make sure that 
COM+ is configured properly. If necessary, reinstall COM+. Restart 
the VSS service (or reboot the machine) and try the operation again. 

 

Q. Why do I get a message that a drive cannot be locked while creating 
an image? 

A. Normally, Active@ Disk Image relies on a snapshot driver to read 
data while creating an image. The snapshot driver tries to get 
exclusive access to the drive. You will get this message under the 
following circumstances: 

• If another application or the operating system is using a target 
partition.  
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• If you are running the program from a Boot Disk (under Windows 
PE)  

• If your machine does not have at least one NTFS partition with 110 
MB of free space.  

Follow the options listed in the message dialog box to resolve the 
situation. 

12.2 Technical Support 
If you are an existing Active@ Disk Image customer and are having 
difficulties using the software, you can find help using any of the following 
options:  

To get more information, see our Web page: www.disk-
image.com/support.htm  
To contact our customer service:  

• E-mail: support@lsoft.net  
• Toll-Free Line: +1 (877) 477-3553  
• International Line: +1 (905) 812-8434  
• Fax: +1 (416) 352-7561 
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